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About This Manual

This manual is a quick guide to HALCON - the software solufimnmachine vision applica-
tions. HALCON is a sophisticated image analysis packagelska for product development,
research, and education. It provides operators coveringda vange of applications: Fac-
tory automation, quality control, remote sensing and &anage interpretation, medical image
analysis, and surveillance tasks. For rapid prototypimgl, €ON includes HDevelop, a highly
interactive programming environment which allows to dasigd test image analysis programs
and to generate C, C++, or COM code.

The manual provides all necessary information to install@nfigure HALCON, to understand
its basic philosophy, and to get acquainted with HDevelop.

The manual is intended for all new users of HALCON. It does asgume that you are an
expert in image processing. Regardless of your skills, giuise easy to work with HALCON
using HDevelop. Anybody should be able to understand the B4&LCON principles to
solve his image analysis problems quickly. Nevertheldss, helpful to have an idea about
the functionality ofgraphical user interfaces (GUf) and about some basic image processing
aspects.

The manual is divided into the following chapters:

e Introducing HALCON
This chapter provides a short overview of the HALCON systaiah @oints out additional
sources of information about HALCON.

¢ Installation, Licensing, Configuration
This chapter explains how to install and configure HALCONrtRermore, it describes
the different types of licenses and how to obtain them.

e A First Look at HDevelop
This chapter contains a complete HDevelop session shovawnwdgdisolve a specific image
analysis task from the scratch.

e Philosophy of HALCON
This chapter explains the basic data structures and messhamf HALCON.

e Using Parallel HALCON
This chapter shows how to use Parallel HALCON.

e Tips and Tricks
This chapter contains helpful information, e.g., for trimdooting.

LConsult your platform’s documentation for general infotio.



Release Notes

Please note the latest updates of this manual:

Edition 6¢c, HALCON 6.1.3 (April 2004)

The manual now warns that after updating to a maintenaneagselthat uses a newer
version of the FLEXIm license manager software, you mudareshe license manager
daemon.

Edition 6b, HALCON 6.1.2 (May 2003)

The manual now uses the terms “license / license file / lickagéand “update / upgrade”
consistently. Furthermore, it warns that the number of nexlshould be determined in
the actually used environment and describes how to cusethi port number of the
floating license daemon.

Edition 6a, HALCON 6.1.1 (December 2002)

The manual has been clarified and extended at many pointexgample, it now clearly

states that an application can only use one HALCON languageface, that the license
file MUST be called license.dat and describes how to upgralieease. DOS shells
are now called Windows Command Prompts. Furthermore, ttteoseregarding floating

licenses has been extended and the troubleshooting fdepmsloluring uninstallation now
differentiates between HALCON 6.0 and 6.1. Finally, the oedrreflects the support of
gce-3.2.

Edition 6, HALCON 6.1 (June 2002)

The problems occurring in conjunction with the new versidthe dongle driver required
for HALCON 6.0.2 and their solution are described in the esponding sections. Fur-
thermore, the installation process is now described in rdetail, including information
on how to switch between different HALCON versions. A newtggtcontains additional
information for users of ActivVisionTools.

Edition 5b, HALCON 6.0.2 (February 2002)
The manual now contains more details regarding the use dfldsr{parallel port and
USB) including how to install, configure, and uninstall ttegresponding device drivers.

Edition 5a, HALCON 6.0.1 (July 2001)

The manual now contains more information about how to ihst&LCON and the license
file when using floating licenses and about the customizaifadhe port number of the
license server daemon. Furthermore, the section 'Trobbtasg’ now offers help if
licensing via a network board fails under Windows 2000.

Since HALCON 6.0.1 does not support HP-UX anymore, the spoading sections have
been deleted from the manual.

Edition 5, HALCON 6.0 (October 2000)

The manual has been completely revised regarding struahdeontent, with exception
of the HDevelop example session. An additional chapter eomieg Parallel HALCON
has been introduced. The information about installinggn&ng, and configuring HAL-
CON has been extended and moved to an own chapter. The ctfalplesophy” has been
extended by a section describing the HALCON frame grablierfece.
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Chapter 1

Introducing HALCON

Congratulations! With HALCON you have chosen a sophistidamage analysis package de-
signed for product development, research, and educatigib.CGN provides a unique library
with about 1000 operators covering a wide range of imageyarsatasks, data visualization,
and a comfortable debugging mechanism. HALCON operatordeaused within C and C++
programs on Windows NT/2000/XP and many UNIX platforms. didiion, under Windows
NT/2000/XP , HALCON has a COM interface. This allows you t@ WALCON operators
from Visual Basic, for example. Furthermore, it is very e&syntegrate your own specific
operators into the system.

The HALCON data structures for iconic data provide a veryeoment handling of images, re-
gions, and contours. Optimized algorithms allow high penfance even on standard hardware.

The HALCON system also includes the programming envirortrifevelop which allows to
speed up the design of image analysis programs. A smarteohip based on aoperator
knowledge basprovides information about each HALCON operator, e.g.so@able succes-
sors, possible alternatives, cross references, etc.

From version 6.0 on, HALCON exists in two versions:Besides “standard” HALCON you
can now choose Parallel HALCON. In addition to HALCON's ineagrocessing functional-
ity, Parallel HALCON automatically exploits multi-proces hardware and supports parallel
programming. Seeection 1.3or more information on Parallel HALCON.

Let's start with some facts describing the main charadtesi®f both HALCON versions.

1.1 Facts about HALCON

O HALCON's comprehensive operator library supports efficiert, flexible image pro-
cessing and eases the development of image analysis progsam

HALCON's operator library containgbout 1000 operatorsThe operators can be used
in any combination. All HALCON applications (e.g., HDevplor HALCON/C++ pro-
grams) make use of the library to perform image processsigta

The operators exhibitlaroad range of functionalityfrom simple tasks (e.g., “read image
from file”) to complex processes (e.g., “estimate state byréa filtering”). Basically
they all have a rather lean complexity and are meant to psosiegle steps of a task
instead of the whole task. So, the typical solution of an ienagalysis problem consists

1



2 CHAPTER 1. INTRODUCING HALCON

of a combination of several HALCON operators. This concdjaws much greater
flexibility than others based on fewer, but more complex afwes that are specialized
to perform a certain task. Specialized operators are ontgtda for special tasks and
become worthless when the task changes. In contrast tdHAISCON operators may
be used in any combination.

Among the great number of operators there are some that mnepiethe same task by
different algorithms. This allows to vary how fast and psety a task is performed.
Consider pattern matching, for example: For a task where i@ rough positions of
matching points are needed, but where the results must liemeet as fast as possible,
the operatorfast_match may be used. In contrast to thisest_match is the better
choice when needing the exact positions (even with subpis@lracy) by using a more
time-consuming algorithm.

O HALCON processes color and multi-channel images

HALCON works on all kinds of image data — binary, monochroroelor, or multi-
channel images. You may use all these kinds of images in tme saanner. Multi-
channel images are useful to work on images that were achjoyra multisensor system.

O HALCON implements efficient, fast region processing

This speeds up the processing and eases the handling ofisedtegions may overlap
and can be of any size. They are stored by an optimized ergddireduce memory
costs.

O HALCON allows to focus image processing on a region of inters.

Each image object has a domain — its area of definition — thabeachanged by the
user. When performing an image operator, it is processey within the domain of
the input image. This concept allows to focus image proogssn regions of interest
(ROIs) and therefore to speed it up.

O HALCON provides very fast pattern matching operators.

Pattern matching is very helpful in numerous areas of agfdio, but often not used
due to its costs of computation time. HALCON allows to usegratmatching where
you want to, as it uses a very efficient implementation ofaasipattern matching algo-
rithms.

O HALCON provides shape-based matching operators that work een in the presence
of occlusion or clutter.

HALCON provides not only pattern matching but aldtape-based matchirugperators.
With these operators, you can recognize objects even ifdhegcaled, partly occluded
or in the presence of clutter or changing illumination coiedis. From version 6.1 on,
HALCON provides the auxiliary todHMatchlt, which lets you configure and test the
matching process with a few mouse clicks; besides, thishelps you to optimize the
parameters interactively to get the maximum matching speddecognition rate.

O HALCON provides an easy handling of tuple objects and proceses tuple elements
simultaneously.

Tuples are very helpful in many areas of application, siheg enable you to work with
sets of images, regions, or control data. With HALCON, tapd objects or control
values can be handled just as one object. Operators cam eibhle on a single or on
a tuple object. You need not bother about the amount of eleweithin a tuple. You
simply pass one variable containing the tuple to an oper&t&t. CON decomposes it

Getting Started with HALCON, 2005-02-01



1.1. FACTS ABOUT HALCON 3

and works simultaneously on the tuple elements.

O HALCON is based on an efficient management of image and data géucts.

The HALCON memory management uses fast, efficient algosttorspeed up image
processing. It provides mechanisms for controlled memocgss and services for de-
bugging, such as checking with every deallocation whethgneite access exceeded
the allocated memory block. The HALCON image database pgesvseveral services
for object handling to allow a fast and transparent access&ge data. Images are
held in memory. To reduce memory costs data is shared byreliff@bjects whenever
possible.

O HALCON provides interfaces to the programming languages CC++, and COM.

The HALCON system includes interfaces to the programmingulages C, C++ , and
COM:. This allows you to use HALCON operators inside your own C#Cer COM
programs and to build stand-alone applications.

O HALCON provides the tool HDevelop for interactive developnent of image analy-
sis programs
In most cases, developing image analysis programs is a eanapld time-consuming
task. To help the user to find the right operators and paramfgea given task, HAL-
CON provides th&Computer Aided Vision Engineering tddDevelop . This eases de-
veloping programs in several ways: First, HDevelop hgsaphical user interfacéhat
allows an easy, intuitive handling of operators and imada.daecondly, operators can
be processed and combined interactively. All results amaeniately visualized so that
the user can experiment with different operators and paemealues and directly sees
the result. Moreover, HDevelop supports the user by sugmeappropriate operators
and parameter values. Ammline helpexplains how the operators work and illustrates
their usage by examples.

If you are satisfied with the result you can save the develppegram either in a special
HDevelop file format to load it again into HDevelop later onexport the program as
C, C++, or COM source code. By exporting, the program can lbd by other image
analysis applications and can be edited and optimizedkesahy “hand-written” image
processing program.

O HALCON already provides interfaces to more than 50 frame grébbers.

HALCON supports more than 50 frame grabbers (the currebtchs be found at
http://www.mvtec.com/halcon/) by providing interfaces to their SDKs. To estab-
lish a connection to one of these frame grabbers, all you teegd is to call the operator
open_framegrabber with parameters describing the desired image format arttbgrg
mode. Then, you can grab images simply by calling the opegatt_image.

O New frame grabbers may easily be integrated

If you use a frame grabber not already supported by HALCON,gan easily integrate

a corresponding interface into HALCON. For this, HALCON yides a transparent
frame grabber interface with sample source code for integyaew frame grabbers.
The only thing you have to do is to adapt this code to a speciimé grabber and
to link it to the HALCON code. Thé&rame Grabber Integration Programmer’s Manual
describes in detail how to do this.

1 COM is a Microsoft standard for component-based softwareggams written in COM can be used in
environments such as Visual Basic , Visual C++ , Microsoff TN or Delphi.

HALCON 6.1.4



4 CHAPTER 1. INTRODUCING HALCON

Alternatively, you can convert your own images to HALCON gea by passing HAL-
CON a pointer to the image buffer using the opergtar_imagel_extern.

O HALCON may easily be extended by new operators

Although HALCON already contains about 1000 operators mous tasks, you may
wish to implement a new one, e.g., in order to access a spemidivare or to imple-
ment an alternative algorithm. To do so, HALCON provides Extension Package
Interface that allows the integration of new operators (emgented in C) in form of
so-calledextension packageslt contains several predefined routines and macros for
the easy handling of image data and memory objects in C. Ommwvaoperator has
been successfully integrated, it can be used like any ot#drGON operator. The
Extension Package Programmer’s Manaahtains detailed information about extend-
ing the operator library.

O HALCON allows continued application of already implemented image processing
software.

Software engineering is a time consuming process and in cassis expensive as well.
So, everyone is interested in using already implementetvacé as long as possible,
and no one is bent on re-implementing their software withryevestallation of new
software components. Therefore, HALCON supports the naetl application of al-
ready implemented software: Convert your programs into H&WCON operators to
use them within HALCON as described above. Moreover, HALO@ixtly restricts the
hardware configuration. A wide range of machines and systamde used. Various
frame grabbers are supported. New ones may be easily itedgisee below). Thus,
you need not change your hardware configuration and therefso need not to change
your software.

O HALCON supports a wide range of platforms.

HALCON is largely architecture independent and thereftiena you to use the system
of your choice. It supports different operating systemshsas Windows NT/2000/XP
, Linux , Solaris , Tru64 UNIX (formerly called DIGITAL UNIX )or IRIX . See
section 1.Zor more information.

O HALCON supports multi-threaded applications by being thread-safe

HALCON is thread-safe under Windows NT/2000/XP, Linux, éwlaris. Note, that
for an extensive use of parallel programming techniques, sfmuld choose Parallel
HALCON (seesection 1.3

O HALCON supports data exchange with other applications

For easy exchange of image data HALCON supports severabfitedts, such as Tiff,
Sun-Raster, Gif, PNM, PNG, JPEG, PCX, XWD, BMP, binary. QOtiata (e.g., inte-
ger result values for image coordinates) may be exchangethgiHALCON language
interfaces.

Getting Started with HALCON, 2005-02-01



1.2. SYSTEM REQUIREMENTS 5
1.2 System Requirements

Table 1.1shows the requirements for running HALCON 6.0 on the diffiéreupported op-
erating systems. It should run on newer versions of an dpgraystem; however, we cannot
guarantee this. Windows NT is no longer supported on Alpbagssors, following Microsoft’s
corresponding decision.

Operating System Processor Compiler

Windows NT 4.0/ 2000 / XH compatible to Intel Pentium MS Visual Studio

Linux 2.2/2.4 compatible to Intel Pentiumgcc 2.95, gcc 3.2/3.3
Solaris 7 SPARC cC

IRIX 6.5 MIPS CC

Tru64 UNIX 5.1 Alpha CXX

Table 1.1: Platforms supported by HALCON .

Note, that under Linuxibc6 (glibc-2.1.x) is required, which is the case for most current
Linux distributions like RedHat or SUSE. Please check yastridution’s documentation.

HALCON can also be used on the Philips TriMedia DSP, with tbstltcomputer running Win-
dows NT/2000/XP. Please refer to tHAALCON/C User’s Manuafor more infomation.

1.3 Introducing Parallel HALCON

To put it in a nutshell, standard HALCON is optimized for rummsequential programsn
single-processor boardsUnder Windows NT/2000/XP , Linux , and Solaris , HALCON is
thread-safei.e., it can be used in multi-threaded programs. HowevkeHAL CON operators
are execute@xclusivelythus threads will have to wait for each other.

In contrast, Parallel HALCON suppomsrallel programminge.g., multi-threaded programs)
by being thread-safand reentrant This means that multiple threads can call a HALCON
operator simultaneously Parallel HALCON is available for Windows NT/2000/XP , Lixu
and Solaris .

Besides supporting parallel programming, Parallel HALC&NXomatically parallelizes opera-
torsif started on multi-processor hardware, e.g., a dual-pemboard. This mechanism is fully
compatible to older HALCON versions, i.e., old HDevelop,#C6r C programs do not need to
be changed.

The parallelization mechanism is based on distributingiéita which has to be processed, i.e.,
the images, on multiple threads that run on different preces(so-calledlata parallelisn).
For example, for a filtering operation on a four-processartidhe image will be split into
four parts which will then be processed in parallel by fouetids executing the (same) filtering
operator. Together with HALCON'’s philosophy for treatingages and regions, this form of
parallelization is very efficient because images need nbétoopied.

°Note, that some operators can only be called exclusivelplme of functional or technical reasons. See
section 5.2.Tor more information.

HALCON 6.1.4



6 CHAPTER 1. INTRODUCING HALCON

The degree of parallelization is optimized online to mirdaemthe parallelization overhead. For

example, very small images will not be processed in parakethe overhead would surpass the
parallelization speed-up. Moreover, not all HALCON operatlend themselves to paralleliza-

tion.

To be able to exploit your multi-processor hardware optiyn&arallel HALCON has to check
the hardware once after being install&ection 5.1.describes how to start and configure this
initialization.

Note, that Parallel HALCON is designed fehared-memory systemse., systems in which
multiple processors share a common memory as it is the caggofoal multi-processor boards.
The main reason is that only in a shared-memory system thizadshare the HALCON object
database and do not need to copy images. This limitation snibam Parallel HALCON is not
suited to the use on workstation clusters or other multepssor hardware that does not offer
shared memory.

Getting Started with HALCON, 2005-02-01



1.4. ADDITIONAL SOURCES OF INFORMATION 7
1.4 Additional Sources of Information

For further information you may consult the following mafsia

e HDevelop User’'s Manual
An introduction to the graphical development environmdrthe HALCON system.

e HALCON/C++ User's Manual
How to use the HALCON library in your C++ programs.

e HALCON/C User’'s Manual
How to use the HALCON library in your C programs.

e HALCON/COM User’s Manual
How to use the HALCON library in your COM programs, e.g., irsival Basic.

e Extension Package Programmer’s Manual
How to extend the HALCON system with your own operators.

e Frame Grabber Integration Programmer’s Manual
A guide on how to integrate a new frame grabber in the HALCOsteawy.

e HALCON/HDevelop, HALCON/C++, HALCON/C , HALCON/COM
The reference manuals for all HALCON operators (versiomdHiioevelop, C++, C, and
COM).

e Application Guide
Multiple, independent documents called Application Npwastten from the point of view
of developing machine vision applications with HALCON. Badote covers a specific
topic, e.g., how to use shape-based matching to find andZeaajects.

All these manuals are available as PDF documents. The nefenmanuals are available as
HTML documents as well. For the latest version of the manplglase check

http://www.mvtec.com/halcon/

HALCON 6.1.4
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Chapter 2

Installation, Licensing, Configuration

Before describing how to install and configure HALCON, legdke a look at the different
HALCON versions and licensing schemes.

You can obtain HALCON in three versions:

1. Thedemo versionis basically a version of HDevelop with the full image progieg
functionality but some limitations, e.g., without framebgber or programming language
interfaces. Using the demo version, you can test all HALCQidrators within the
HDevelop environment for an unlimited amount of time.

2. At the other end of the spectrum lies tiodl version which is used to develop applica-
tions based on HALCON. Besides HDevelop, this version ietuinterfaces to about
50 frame grabbers and an interface to integrate additioma$,danguage interfaces to
C, C++, and COM, and the Extension Package Interface, whicWwsyou to integrate
your own HALCON operators.

3. If you have developed an application based on HALCON, yaw @btain aruntime
versionof HALCON, which only contains the image processing funeditity needed in
your application. A runtime version does not include HDeypel

For the development version and for the runtime version yemdra corresponding licensehe
demo version can be used without a licenBleere are two possible licensing schemes:

1. Nodelocked licenseme only valid for one specific host or hardware dongle.

2. For a development version you can also get a so-céthating license Such licenses
are valid on arbitrary hosts within a local network. A soledlicense servechecks
the number of currently active HALCON applications. A nevpbgation can be started
only if the overall number of licenses is not exceeded.

Note, that a computer acting as the HALCON license servet netbe a “server” in the
sense that it must be a “big” server machine or have a speaaoididt operating system,
e.g., Windows NT Server, installed. Moreover, you can u$ierdint architectures for
the license server and the HALCON applications, respdgtieey., a Linux workstation
for the license server and Windows for running HALCON. Thé&aequirement is that
the computer acting as the license server must be accessibleever HALCON is to
be used.

Please note, that for evaluating purposes you can obtaimpai@ryevaluation licensérom
you distributor free of charge.
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2.1 Installation

This section describes how to install HALCON from CD; how ton-i
stall HALCON from the WWW s described in MVTec’s download ear
(http://www.mvtec.com/halcon/download). Most of the work is done by the pro-
vided installation scripts. The fileelease notes.html within the HALCON package
contains the latest information.

Except of UNIX-specific sections, file paths and environmemiables are printed in the Win-
dows convention, e.g.,

JHALCONROOT%\examples\extension_package\halconuser

to denote the subdirectohalconuser containing an example package within the HALCON
base directory referenced by the environment variialecONROOT (seesection 2.4for more
information on environment variables). The same expressi&NIX convention would look
like

$HALCONROOT/examples/extension_package/halconuser

Prior to installing a new HALCON version, e.g., HALCON 6.1.x over HALCON 6.0.x,
you should uninstall any existing old version.Under Windows, this is especially important in
order to clean up the registry. Ssection 2.2about how to uninstall HALCON. An exception
to this rule is if you are using ActivVisionTools 1.0 to 1.3cawant to install HALCON 6.1.x:
In this case you must keep your old HALCON 6.0.x installation

If you want to install a new maintenance release over aniegiselease based on the same
version, e.g., HALCON 6.1.1 over HALCON 6.1, you can use a&gdepdate mechanism (see
section 2.1.8

2.1.1 Installing HALCON Under Windows NT/2000/XP

To install HALCON on Windows NT/2000/XP systems, simplyensthe CD. This should
automatically start the setup program. If the setup progtaasn’t start automatically, execute
theSetup.exe program located in the directont-x86 of the CD. Please note, that you need
administrator privileges in order to install HALCON.

First, the setup program checks whether your system meteduirements for running HAL-
CON (seesection 1.2

Then, it checks whether HALCON is already installed on yoomputer and, if yes, which
release is installed:

e same releaself you already installed the same release, the setup detestine installed
components and lets you install additional parts.

e same version: If you already installed another release of the same vergan, if the
setup of HALCON 6.1.1 detects HALCON 6.1, the setup enabtesty replace the in-
stalled components by those of the new release. If you aregkating licenses,
please note the following: After installing HALCON 6.1.2 tre computer acting as the

Getting Started with HALCON, 2005-02-01
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license server, you musestart the license manager daemonthis also applies if you
update from HALCON 6.1 or 6.1.1 to HALCON 6.1.3. Ssection 2.3.4.3or detailed
information.

e other version: If the setup detects a release of another HALCON version, &.the
setup of HALCON 6.1.1 detects HALCON 6.0.3, it asks whethau yant to keep the
old version. For more information about switching betwearitiple HALCON versions
please refer tgection 2.1.5

The setup program also checks whether you have installad\AsibnTools, and whether the
installed version is compatible to the current HALCON versi Please refer teection 2.1.6
for more information.

After all these checks, the installation wizard allows tesfy whether you would like to in-
stall

e the full HALCON version ¢ompact, Custom, Typicall),
e the runtime version onlyRuntime), or
e justthe demo versiondevelop_demo.exe (Demo).

Note that you can install additional parts of HALCON at a tdime by inserting the CD again
and selecting the parts you need.

After this selection, the setup program asks whether t@lintte driver programs, which are
necessary if you want to use a dongle licer$3ection 2.3.%rovides detailed information about
dongle drivers, including how to install them manually ifuydidn’t let HALCON do it.

The next dialog asks whether the computer is to act afidagng license serverin this case,
the setup program installs the so-callegnse manager daempa system service that manages
your floating licenses. Note that when using floating liceng®u need to install the license
manager daemon only on one computer: the license servasdlefer tsection 2.3.4or more
information about floating licenses, e.g., how to instad! lilkense manager daemon manually.

After some further questions the actual installation start

2.1.2 Installing HALCON Under UNIX

To install HALCON on UNIX systems, mount the CD, e.g., on tlrectory /cdrom. On most
systems, you neetbot rights to do so. Note that on some systems, most notably L_ithex
default mount entry, usually ifetc/fstab, does not allow user to execute programs on a CD.
In such cases, you have to mount the CD explicitly with a comuhgamilar to the following:

mount /dev/cdrom /cdrom

For the installation, start the shell scripistall-unix which is located in the top-level di-
rectory of the CD. This script will ask you in which directoypu want to install HALCON;

Please note, that if you chooSgpical, most of the image sequences are not installed. This meahs th
example programs based on such an image sequence cannat b quick remedy in such a case is to mount
the HALCON CD again, as the example programs also look trarthe images. Of course, you can also install
additional parts of HALCON at a later time.

HALCON 6.1.4
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the environment variablBALCONROOT has to be set to this directory later, ssection 2.4.2
Furthermore, the script asks whether to install variousmaments of HALCON.

Since all directories and files on the CD are read-only, yoy gt some warnings about
changed permissions if you run the installation script asrdimary user (asoot, no warnings
of this kind should appear). Furthermore, on some systemsnay get complaints about the
fact that the CD contains files with file names longer than 3#atters.

Note, that the installation script checks whether youreaystieets the requirements for running
HALCON (seesection 1.2

After the installation, several environment variablescheebe set in order for HALCON to
work. Seesection 2.4.Zor details.

Note, that you can install additional parts of HALCON at amye by mounting the CD again
and copying the corresponding directories and files to thetdry where you installed HAL-
CON. To copy directories, open a shell, change into the roettbry on the CD, and type

tar -cf - <directory_to_be_copied> | ( cd $HALCONROOT; tar -xf - )

If you are using floating licenses, please note the followiisfier installing HALCON on the
computer acting as the license server for the first time, yoastrnstall and start the license
manager daemon as describedattion 2.3.4.2If you update from an HALCON 6.1 or 6.1.1
to HALCON 6.1.2 or 6.1.3, you muséstart the license manager daemoypseesection 2.3.4.3
for detailed information.

2.1.3 Updating HALCON (Windows NT/2000/XP only)

For Windows NT/2000/XP systems, there is a special mechamdich lets you up-
date HALCON to a newer maintenance release of the same wersig., from HAL-
CON 6.1 to HALCON 6.1.1 or 6.1.3. Please refer to the HALCONwdlmad area
(http://www.mvtec.com/halcon/download) for more details.

Special Information for Users of Floating Licenses

If you are using floating licenses, please note the followBgfore extracting the ZIP file on the
computer acting as the license server, you rsteg the license manager daemoas described

in section 2.3.4.10therwise, you will get an error message during the extracbecause the
two filesmvtecd. exe andlmgrd.exe cannot be replaced while the daemon is running. In this
case, stop the daemon and repeat the extraction.

After the extraction, you must restart the license managentbn (sesection 2.3.4.8

2.1.4 The Installed File Structure

Let’s take a look at the installed file structure in the dioeg#HALCONROOTY. In the following,
the most important directories and files are described pri€flease note, that depending on
your installation, not all directories will be present.
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e FLEX1m: This directory contains programs used for licensing @astion 2.3, in subdi-
rectories corresponding to the different platforms.

e bin:

This directory contains HALCON programs, for example HDepe(Windows:

hdevelop.exe; UNIX: hdevelop), again in subdirectories corresponding to the different
platforms. For Windows, this directory also contains thelDlersion of the HALCON
libraries and the libraries for the supported frame grabbeerfaces.

e calib: This directory contains description files for the calibvatplates, which you can
use to calibrate your camera.

e doc\pdf: Here, you find the PDF version of the user's manuals (subine@anuals
and of the reference manuals (subdirectosyerence).

e ecxamples: The subdirectories of this directory contain example progg for the different
parts of the HALCON system:

>

>

application _guide: Examples referenced in the Application Guide.

c: Examples for using HALCON within the programming languagésé€e also the
HALCON/C User’'s Manua).

cpp: Examples for using HALCON within the programming language-Qsee also
the HALCON/C++ User’'s Manua).

c#. Examples for using HALCON within the programming language(€ee also
the HALCON/COM User’s Manua).

delphi: Examples for using HALCON within Borland Delphi.

fg_integration: Example programs for frame grabber interfaces (see also the
Frame Grabber Integration Programmer’s Manual

extension_package: The example user packagealconuser (see also the
Extension Package Programmer’s Manual

hdevelop: Examples for using HDevelop, together with the example pro-
grams described in the manudbetting Started with HALCON (subdirectory
Manuals\Getting Started) and in theHDevelop User's Manua(subdirectory
Manuals\HDevelop).

mfc: Examples for using HALCON together with MFC (see also the
HALCON/C++ User’'s Manuahnd theHALCON/COM User’s Manua).

motif: Examples for using HALCON together with Motif (see also the
HALCON/C++ User’'s Manua).

vb: Examples for using HALCON within Visual Basic, together kvthe example
programs described in tH#ALCON/COM User’s Manual

vb.net: Examples for using HALCON within Visual Basic .NET (see atbe
HALCON/COM User’s Manua).

Please note, that the examples should not be used directiwdaeasons: First, on most
platforms only the user who installed HALCON is allowed toesa (modified) example
program. More importantly, on some operating systems roisars have the permission

HALCON 6.1.4
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to create new files in the example subdirectories; this caesers in those example pro-
grams which contain operators that write data to files. Teearpent with examples we
therefore recommend to create a private copy in your own ingrétirectory.

e filter: This directory contains predefined filter masks.

e images: This directory contains example images and, in subdirsgpimage sequences.
These images are used by the example programs describegl abov

e include: This directory contains the header files which are necegsange HALCON
within the programming languages C or C++.

e 1lib: This directory contains the HALCON libraries and the libearfor the supported
frame grabbers interfaces (Windows: file extensiaib; UNIX: file extension.so),
again in subdirectories corresponding to the differentfqiens.

e license: Thelicense fildicense.dat must be placed in this directory (ssection 2.3
e lut: This directory contains predefined look-up tables.

e ocr: This directory contains trained fonts.

2.1.5 Switching Between Different HALCON Versions

You can install multiple HALCON versions on a computer andrttswitch between them.
Under Windows NT/2000/XP,you must adapt those environment variables that are setgluri
the installation, i.e.,PATHY, %HALCONROOT%, and%,HALCONIMAGESY, and those you set yourself
(e.g.,.HALCONEXTENSIONSY). Please refer teection 2.4.Xor more information about setting
environment variables.

If you are using the HALCON/COM interface, you must also egister the corresponding
DLL halconx.dll, for example as follows: Open a Windows Command Prompt aadgh
into the subdirectorpin\i586-nt4 of the root directory of your “old” HALCON installation.
Unregistemhalconx.d1l by typing

regsvr32 /u halconx.dll

Then change into the corresponding subdirectory of yougrdthtALCON installation and reg-
ister itshalconx.d11 by typing

regsvr32 halconx.dll

As an alternative to the Command Prompt, you can unregisiregistethalconx.dll via
the dialogStart > Run together with the Windows Explorer: In the latter, “openeétdi-
rectory bin\i586-nt4 of the root directory of your old HALCON installation. Nowype
regsvr32 /u the dialogRun and then drag and drdglconx.d11 from the Explorer into the
dialog, where it automatically appears with the full patto. ékecute the command, click.
Then, open the directonyin\i586-nt4 of the root directory of the other HALCON installa-
tion in the Explorer, typeegsvr32 in the dialogRun, drag and dropnalconx.dll from the
Explorer into the dialog, and again click.
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Under UNIX, you switch to another HALCON version by setting the envir@mtnvariables
$HALCONROQT (and derived variables lik@HALCONIMAGES), $PATH, and $LD_LIBRARY PATH
accordingly (see alssection 2.4.2

2.1.6 Information for Users of ActivVisionTools

Only ActivVisionTools 2.1 and 2.2 are based on HALCON 6.1 ilevthe older versions 1.0
to 2.0 are all based on HALCON 6.0 (or HALCON 6.0.1); thus, bstalling HALCON 6.1.x
you would disable such an older ActivVisionTools instatlat Therefore, the setup program
of HALCON 6.1.x checks whether there is an ActivVisionTomwlistallation on your computer.
Depending on the version, the following action is performed

e ActivVisionTools 2.1 or 2.2
If the setup of HALCON 6.1.1 or higher detects ActivVisiorole 2.1 or 2.2, no fur-
ther action is required, as this version is fully compatibl&nfortunately, the setup of
HALCON 6.1 wrongly warns that ActivVisionTools 2.1 is not canpatible; you can
safely ignore this warning and proceed.

e ActivVisionTools 2.0
If HALCON 6.1.x detects ActivVisionTools 2.0, it offers teplace the corresponding
OCX ActivVTools.ocx with a new one which is compatible to HALCON 6.1.x. Typi-
cally, you will choose this option. If not, you can replacen@nually as follows: Open a
Windows Command Prompt and change into the subdireetiyi586-nt4 of the root
directory of your ActivVisionTools installation. Unreges ActivVTools.ocx by typing

regsvr32 /u ActivVTools.ocx

Then delete the OCX (or rename it) and replace it by the new wh&h can be found
on the CD in the directorgisc\i1586-nt4\avt20, or in the ActivVisionTools download
area http://www.activ-vision-tools.com/download). Register the new OCX by

typing

regsvr32 ActivVTools.ocx

As an alternative to the Command Prompt, you can unregisetregister the OCX via
the dialogStart > Run together with the Windows Explorer: In the latter, “open&th
directorybin\i586-nt4 of the root directory of your ActivVisionTools installatio Now,
type regsvr32 /u the dialogRun and then drag and drajctivVTools.ocx from the
Explorer into the dialog, where it automatically appearthvihe full path. To execute
the command, clickX. Then, replace the OCX with the new open, typgsvr32 in the
dialogRun, drag and drofictivVTools. ocx from the Explorer into the dialog, and again
click OK.

If you decided to switch back to an older HALCON version ascdiégd insection 2.1.5
you must of course unregister the new OCX and register therdclif you deleted it you
can recover it from the corresponding directory on the AdsionTools 2.0 CD.

e ActivVisionTools 1.0-1.3
In contrast to ActivVisionTools 2.(ActivVisionTools 1.0 to 1.3 cannot be used together IIl
with HALCON 6.1.x, i.e., there is no compatible OCX available. If the setupgpam
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of HALCON 6.1.x detects such an ActivVisionTools versiorg.eActivVisionTools 1.3,

it therefore only warns that by continuing you will disablewy ActivVisionTools instal-
lation. If you still want to use your ActivVisionTools indlation, you must also keep
your old HALCON 6.0.x installation and switch back to it assdebed insection 2.1.5
Note that if you only want to evaluate HALCON 6.1.x, you camimize the switching
effort by installing only the demo version: In this case thexno need to re-register the
HALCON/COM interface libraryhalconx.d11.

2.2 Uninstallation

2.2.1 Uninstalling HALCON Under Windows NT/2000/XP

There are multiple ways to uninstall HALCON; please note tiwt all are available for older
versions of HALCON:

1. Inthe system control panel choas®l/Remove Programs.

2. If the HALCON release you want to uninstall is newer tharsign 5.1: Selec$tart
> Programs > MVTec HALCON »> Uninstall HALCON.

3. Fromversion 5.2 on, the HALCON setup program checks varé¢ttere is an old version
of HALCON and allows you to uninstall it. This is the prefettr&vay since it avoids the
problem with the path variable described below. Note, harethat this method
does not work if you want to uninstall an older maintenanéease based on the same
version of HALCON.

Typically, thisis all you have to do. If you encounter anylgeims, please refer gection 6.5.2

Note, that the uninstallation removes exactly those fileewtvere installed. This has two im-
plications: If you added files after the installation, ergew frame grabber interfaces, extension
packages, images, or manuals, these files and the corresgatkctories will “survive” the
uninstallation. On the other hand, if you only modified a fdey., an example, without chang-
ing its name the uninstallation will remove it neverthejegsu might therefore want to copy
such files to another directory before starting the unitegtah.

The uninstallation warns if it encounters DLLs or executalthat might be or are actually used
by another application. The warnings regardita conx.d11 andHFGDirectShow.d11l can
safely be ignored, i.e., the files can be removed. In contveanings regardingvtecd.exe
andlmgrd.exe are serious; they indicate that the license manager daemsimatalled manu-
ally but not uninstalled. In this case, we recommend to abertininstallation process, uninstall
the license manager daemon manually as describgeltion 2.3.4.1and then restart the unin-
stallation of HALCON.

The uninstallation process will not remove amger-specific settingsrhis means that registry
entries concerning, e.g., the layout of HDevelop or its fildry, will be left in the category
HKEY_CURRENT_USER > Software > MVTec > HALCON. You may remove these entries manually
without risk. Furthermore, it does not remove the donglgets as they might be needed by
another applicatiorsection 2.3.%lescribes how to remove them manually.
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Special Information for HALCON 6.0.2

From version 6.0.2 on, HALCON requires a newer version oftkhiegle driver programs from
GLOBEtrotter (see alseection 2.3.5 However, the uninstallation process does not uninstall
the old dongle driver; as a consequence, during the instailaf HALCON 6.0.2 the new driver
cannot be installed (even if the setup program might statiethie installation was successful!).

Therefore, you mustininstall the dongle driver manually before uninstalling HALCON!
Please refer tgection 2.3.5.1or more information.

2.2.2 Uninstalling HALCON Under UNIX

To uninstall an existing HALCON system, just remove the eotdg of the HALCON base
directory$HALCONROOT and all its subdirectories, e.g., by executing

rm -rf $HALCONROOT

Furthermore, remove the subdirectamydevelop of the directory referenced by the environ-
ment variabléiOME (seesection 2.4.2, HDevelop creates this directory to save options, window
positions, and the file history.

The uninstallation process will not remove amer-specific settingg his means that environ-
ment variables remain unchanged and have to be adaptedetedietanually.

If you called the operatotheck par_hw_potential from Parallel HALCON 6.0 beta to ini-
tialize Parallel HALCON (sesection 5.1.), the file .halcon par_info which contains the
extracted information about the host computer will be lefthe directory referenced by the
environment variabl#0ME (seesection 2.4.2
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2.3 Licensing

HALCON checks whether the product is licensed to the usehn wie help of the FLEXIm
license managémpackage from GLOBEtrotter. In this section a brief summérthe default
procedure to obtain and install a license will be given.

The first step is of course teelect the computewsn which (in case of a nodelocked license)
you want to use HALCON on or which (in case of a floating licgriseo act as the license
server, i.e., which keeps track of how many licenses of HANC&®e currently in use. Note,
that a computer need not be a “server” in the sense that theytbhde a “big” server machine
or have a special kind of operating system, e.g., Windows Bive3, installed. If you want to
run HALCON on a stand-alone computer, the license servet bruthis computer. If you run
HALCON on a network any computer on the network can serve m&ade server.

In order to obtain a license for HALCON, you havedxtract identifying informatioabout this
computer (sesection 2.3.Xor more details) and send it to your local distributor. lfuyant
to obtain a runtime license, you have to inform your locatrdbsitor which HALCONmodules
you want to use. Please referdection 2.3.2or more information.

You will then receive dicense file Section 2.3.3escribes how to install this file on your
system. Section 2.3.4&ontains additional information for the case you want to aigating
license.

2.3.1 Extracting ldentifying Information

The standard method for identifying an computer requires ttie computer of your choice is
equipped with anetwork card If you are using Windows NT/2000/XP and if your computer is
equipped with @&entium Ill processqrit can be identified by the so-called CPU ID as well.

Under Windows NT/2000/XP, you can also usbadware dongle In this case, the license
will be coupled to this dongle, i.e., you can use HALCON ontarocomputer by moving the
dongle. This has the advantage that you don’t commit yolutiselking a certain computer. You
can use dongles both for nodelocked and for floating licenisethe latter case, the dongle is
used for identifying the computer which acts as the liceesees. You can obtain such a dongle
from your local distributor. The dongle will be deliveredj&ther with the corresponding license
file. Seesection 2.3.50r more information regarding the use of dongles.

2.3.1.1 Extracting Information Using HDevelop

The easiest method to extract identifying information istart the HDevelop demo version
(which is always installed). You start it under Windows NOUR/XP, callStart > Programs

> MVTec HALCON > HDevelop Demo; under UNIX, callhdevelop_demo from a shell. Now,
select the menu itelelp > About. A dialog as depicted ifigure 2.1appears. At the bottom,
it shows all the information available on your computer,ha example the three so-called host
IDs corresponding to a network card, a Pentium Ill, and a tong most cases, you will see
only one ID.

2The full documentation of FLEXIm can be obtained from the KlfE end user manual available at
http://www.globetrotter.com/manual.htm.
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About HD evelop

@ HALCOM - Version B.1.

HDOevelop - Wersion 3.2.

% Tec Software GmbH

tunich, Germany

WL MYEEC. SO

& 1996-2002 MY Tec S oftware GmbH

The hostidz of thiz computer are
network card ID ———» 00e02358e36a, 0003-C1DE-01C3-E7SF, FLEXID=F-36c79bd? 4 dongle ID

CPUID ///T’ -

Figure 2.1: Identifying information in the HDevelop window About.

To obtain a license based on a network card or a Pentium IIl,GBH the corresponding ID to
your local distributor together with the hostname of thisinae in your network (for example,
halconserver). Inthe case of a dongle license, this is not necessary, @asvitbreceive the
license file already together with the dongle.

If HDevelop fails to detect any host IDs although your congputoes have a network card, a
Pentium 1ll, or a dongle, please try to extract the host IDswnadly as described in the fol-
lowing section. If IDs like"ffffffff", "0", or "" appear, please conswdéction 6.5.3or
troubleshooting.

2.3.1.2 Extracting Information Using  1lmhostid

As a (more tedious) alternative, you can extract these IDsidiyg the programmhostid
shipped together with the license manager FLEXIm. Underddivse NT/2000/XP, open
a Windows Command Prompt Under UNIX, open a shell, change into the directory
$HALCONROOT/FLEX1m and then into the subdirectory corresponding to your opegatystem
(e.g.,i586-1inux2.2 Or sparc-sun-solaris7).

To identify a computer by its network card, type 1lmhostid -ether (Or just lmhostid).
Following the example of the previous section, the outpwghnlook like this on a Windows
system:

> Imhostid -ether
lmhostid - Copyright (C) 1989-2000 Globetrotter Software, Inc.
The FLEX1m host ID of this machine is "00e02958e36a"

Send the ID, in this example the string0e02958e36a", to your local distributor together with
the hostname of this machine in your network (for examptg,conserver). If lmhostid
returns"fffff£f£" or "0" please consukection 6.5.3.for troubleshooting.

To identify a computer by its (Pentium IIl) CPU number (Windows NT/2000/XP only), type
lmhostid -cpu64. The output now might look like this:
> 1mhostid -cpu64

lmhostid - Copyright (C) 1989-2000 Globetrotter Software, Inc.
The FLEX1m host ID of this machine is "0003-C1DE-01C3-E79F"

3Do not start the program from the Explorer. Yowstuse a Command Prompt.
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Used Modules
4 Basic operators
4~ Image /region / XLD management
Image fiters
Sub-pixel operators
4~ Template matching
4 Region processing
Maorphology
Background estimation
Optical character recognition
Fouriet descriptors
Wiener filter
Camera calibration
Tools
& System
Barcode reader
Optical character verification

Figure 2.2: Used modules in the example program in chapter 3.

Send the ID, in this example the strit@003-C1DE-01C3-E79F", to your local distributor
together with the hostname of this machine in your netwarsk ¢kamplehalconserver). If
1lmhostid returns"", the reason probably is that the service providing the CPId isabled in
the computer’s BIOS. You can check and enable this serviteaiiBIOS configuration mode;
this mode can only be entered during the booting processaas@leonsulsection 6.5.3.%or
troubleshooting.

To check the dongle ID(Windows NT/2000/XP only), typ@mhostid -flexid. The output
now might look like this:

> lmhostid —flexid
lmhostid - Copyright (C) 1989-2000 Globetrotter Software, Inc.
The FLEX1m host ID of this machine is "FLEXID=7-36c79bd7"

Note, that this number is also written on the dongle.

2.3.2 Runtime Licenses and HALCON Modules

HALCON operators are grouped into so-calladdules Some modules, e.g., '‘Basic Operators’
or 'Image / Region / XLD Management’, are used in all HALCONphAgations, others like
'Background Estimation’ or '1D Bar Code Reader’ will only heeded in special applications.
While the development version of HALCON automatically undés all modules, you can limit
a runtime version to the modules you actually need.

You can check which modules are used by an application in teysw

1. If the application is running in HDevelop (sebapter 3for more information), select
the menu itenFile > Modules... which will open a pop-up dialog as depicted in
figure 2.2 Click Save to save the required modules in a file with the extensiosd in
the currently used directory.
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2. If the application is written in a programming language Q3+, COM), insert the op-
eratorget_modules (See the corresponding entry in the HALCON Reference Manual
for more information) at the end of the program.

Send the thus determined module names to your local digbrilbhen requesting a runtime
license.

Please note that the number of modules depends on the useashement; for example, within
HDevelop an application may need less modules than aftergrg it to Visual Basic. Thus,

we recommend tdetermine the number of modules in the environment used forhe final IIl
application.

2.3.3 Installing the License File

Your local distributor will supply you with éicense file This file must be put into the directory
%HALCONROOTY\1license* and be renamed tbicense.dat, if necessaryy%HALCONROOTY is
the HALCON base directory you have chosen during the iredtah. If you are using the
floating license scheme, you must copy the license file taoafiguters you installed HALCON
on, i.e., the computer acting as the license server and alpaters where HALCON is to be
used, and then restart the license manager daemon as dddsasiection 2.3.4.3

If you upgrade HALCON to a newer version, e.g., from HALCON.&.to HALCON 6.1.x,
your distributor provides you with a so-callaggrade license filen this case, you must append
the content of this file at the end of the old license i 2L.CONROOT% \1icense\license.dat
(seefigure 2.5for an example). Please note that some editors insert $pbeaeacters, which
cannot be interpreted by FLEXIm. Under Windows systems,aeemmend to use WordPad.
Due to a bug in the FLEXIm software, you might encounter peoid if you upgrade twice,
e.g., from HALCON 5.2 to 6.0 and then to 6.1. In this case, gg@e@ontact your distributor for
further instructions.

B

# MVTec Software GmbH (ID: 00e02958e3b6) #

s

FEATURE MVTec_Halcon mvtecd 6.1 01-jan-0000 uncounted BC4D86743889FCACFAC2 \
VENDOR_STRING=65535 HOSTID=00€02958e3b6 ck=109

FEATURE MVTec_HDevelop mvtecd 6.1 01-jan-0000 uncounted \
5CFD86941816A696B16F VENDOR_STRING=65535 HOSTID=00e02958e3b6 ck=30

Figure 2.3: Nodelocked development license, bound to network card.

B R R R R i

# MVTec Software GmbH (ID: FLEXID=7-b285ff7f) #

HEHHHHAH AR H AR AR R R R

FEATURE MVTec_Halcon mvtecd 6.1 01-jan-0000 uncounted 3C574319AF86C4A5DE4A \
VENDOR_STRING=65535 HOSTID=FLEXID=7-b285ff7f ck=35

Figure 2.4: Nodelocked runtime license, bound to dongle.

4See the FLEXIm end user manual on how to configure this losatio
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original license file (HALCON 6.0):

s

# MVTec Software GmbH (ID: 00e02958e3b6) #

s

FEATURE MVTec_Halcon mvtecd 6.0 01-jan-0000 uncounted 9C6D4634F08A932DBC2D \
VENDOR_STRING=65535 HOSTID=00€02958e3b6 ck=82

FEATURE MVTec_HDevelop mvtecd 6.0 01-jan-0000 uncounted \
7CADE63412EF3451B596 VENDOR_STRING=65535 HOSTID=00e02958e3b6 ck=34

upgrade license file (HALCON 6.0 to HALCON 6.1):

B

# MVTec Software GmbH (ID: 00e02958e3b6) #

s

UPGRADE MVTec_Halcon mvtecd 6.0 6.1 01-jan-0000 uncounted \
3COD76C4ADF2BFE51017 VENDOR_STRING=65535 HOSTID=00e02958e3b6 ck=54

UPGRADE MVTec_HDevelop mvtecd 6.0 6.1 01-jan-0000 uncounted \
1CCDC6246E6E497BB0B4 VENDOR_STRING=65535 HOSTID=00e02958e3b6 ck=48

resulting license file after appending the upgrade keys:

B

# MVTec Software GmbH (ID: 00e02958e3b6) #

B

FEATURE MVTec_Halcon mvtecd 6.0 01-jan-0000 uncounted 9C6D4634F08A932DBC2D \
VENDOR_STRING=65535 HOSTID=00€02958e3b6 ck=82

FEATURE MVTec_HDevelop mvtecd 6.0 01-jan-0000 uncounted \
7CADE63412EF3451B596 VENDOR_STRING=65535 HOSTID=00€02958e3b6 ck=34

UPGRADE MVTec_Halcon mvtecd 6.0 6.1 01-jan-0000 uncounted \
3C0D76C4ADF2BFE51017 VENDOR_STRING=65535 HOSTID=00€02958e3b6 ck=54

UPGRADE MVTec_HDevelop mvtecd 6.0 6.1 01-jan-0000 uncounted \
1CCDC6246E6E497BBOB4 VENDOR_STRING=65535 HOSTID=00e02958e3b6 ck=48

Figure 2.5: Upgrading a license from HALCON 6.0 to HALCON 6.1.

Figures 2.3and2.4 show examples for different types of license files for nodkdal licenses;

an example file for a floating license can be found in the folhgasection. The lines starting
with FEATURE are calledlicense keys As you can see, they contain the version number of
HALCON (in the example files:6.1). However, a license is not exclusively bound to this
release. First, a license downward compatible.e., a license for HALCON 6.1 is also valid
for HALCON 6.0. Secondly, a license igoward compatible within a version numbere.,
licenses for HALCON 6.1 are also valid for HALCON 6.1.1. Ifyaipgrade to a newer
version, however, you need corresponding upgrade licesyg® (knes starting witliPGRADE);
figure 2.5depicts an example for upgrading a license from HALCON 6.8A2.CON 6.1.
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2.3.4 Using Floating Licenses

The previous sections already mentioned some issues congehe use of floating licenses:
First, you must select one computer in your network whichoig¢t as thdicense server
i.e., watch over the number of HALCON licenses currentlydjsm this computer, a special
program called thdicense manager daemanust be installed and started (see the sections
below). Secondly, the license file supplied by your distislbunust be copied to all computers
you installed HALCON on, i.e., not only those you want to us&LUEON on but also the
license server. Note that if you get a new license, you mssarethe license manager daemon
after replacing the license files (sgection 2.3.4.8 The same is true if you modify parts of the
license file.

Let’s take a closer look at an example license file fdloating licensein figure 2.6 The line
starting withSERVER tells FLEXIm the name of the host computer acting as the Seeserver
(in the example:halconserver), its identifying information (in the example: network dar
ID), and the port number (in the exampiz:000).

If you didn’t send the name of the license server host compotgour distributor when re-
guesting the license, the corresponding field contains nitwy @nknown; in this case, please
enter the correct host name instead. Another reason forfymaglthe entry for the host name
is, e.g., if you are using a dongle-bound license and wanwitzls the dongle (and the license
server) to another computer in your network. The same apphi@u change the name of your
host computer or, in the case the license is bound to a netwendki D, if you move the network
card to another computer.

You may also customize the port number. This may be nece$sapxample if the default
port number is used already by another software in your coenmetwork. Note, that on many
systems all portsc 1024 are privileged and can only be used by privileged adsbun

Please keep in mind that the information contained in the ditarting withSERVER is used in
two ways: When you start HALCON on an arbitrary computer inyoetwork, it uses the host
name and the port number to locate and contact the licengers€n the computer acting as
the license server, the port number is used when starting@amiiguring the license manager
daemon. Therefore, it is very important that this line i@l in all copies of the license file
in your network!

Depending on where you have installed HALCON on the compuateting as the li-
cense server, you may have to customize the path to the daembscd, which
is in charge of managing the HALCON licenses. Normally, thathp will be

pi i s s e e S s e e e e e B g

# MVTec Software GmbH (ID: 00e02958e3b6) #

i s s e e S s e e e e e R g

SERVER halconserver 00e02958e3b6 27000

DAEMON mvtecd C:\Progra~1\MVTec\HALCON\FLEX1m\i586-nt4\mvtecd

FEATURE MVTec_Halcon mvtecd 6.1 01-jan-0000 1 1CBD8604021DCIDBC868 \
VENDOR_STRING=65535 ck=43

FEATURE MVTec_HDevelop mvtecd 6.1 01-jan-0000 1 4C2DB644BC603179E58F \
VENDOR_STRING=65535 ck=80

Figure 2.6: Floating license, bound to network card.
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%HALCONROOT%\FLEX1m\%ARCHITECTURE),\mvtecd (Seesection 2.4or information about the
environment variablaRCHITECTURE). However, since you cannot use environment variables
in the license file, you must supply this path manually. Not paths including blanks are
not handled properly under Windows NT/2000/XP: Thus, if ywave installed HALCON

to a directory likeC:\Program Files\MVTec\HALCON you will have to use the short path
C:\Progra™1\MVTec\HALCON instead. You can query short path names as follows: Open a
Windows Command Prompt, change into the directory thatasoathe directory or file whose
short name is searched for (hege), and then type

dir /x

Note that the daemomvtecd opens a second port. By default, this port is selected by the
operating system, and thus its number can change. Espeaalatin using a firewall, you might
need to specify the port number explicitly. For this, app#mstringport=numberto the line
starting withDAEMON, for example as follows:

DAEMON mvtecd C:\Progra™1\MVTec\HALCON\FLEX1m\i586-nt4\mvtecd port=28000

Finally, you have to make sure that the license manager daeswastalled and started success-
fully.

2.3.4.1 (Un-)Installing the License Manager Daemon Under W indows
NT/2000/XP

On Windows NT/2000/XP systems, you can let the setup prognatall the license manager
daemon, which will then be started automatically at boottas the system service ‘HALCON
Licenses'.

To check whether the daemon was installed successfullyy tpe Windows dialog show-
ing the state of the installed services. Under Windows NT§ thalog can be opened via
Start > Settings > Control Panel > Services, under Windows 2000 and Windows
XP via Start > Settings > Control Panel > Administrative Tools > Component
Services > Services. If the daemon was installed successfully, the dialog a¢ostine entry
HALCON Licenses

Installing the License Manager Daemon Manually

If you did not install the license manager daemon via theseatuif its installation failed, you
can install it manually at a later time as described belowteNbat you need administrator
privileges for this procedure. Open a Windows Command Ptpoiange into the directory
%HALCONROOT%\FLEX1m\1586-nt4, and type ¢nelong command line):
"installs" -n "HALCON Licenses"
-c "%HALCONROOT%\license\license.dat"

-1 "YHALCONROOT%\license\license.log"
-e "%HALCONRODT%\FLEle\i586-nt4\1mgrd.exe“
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with % HALCONROOT), being the HALCON base directory you have chosen during
the installation. For example, if you have installed HALCON the directory
C:\Program Files\MVTec\HALCON, you type
"installs" -n "HALCON Licenses"
-c "C:\Program Files\MVTec\HALCON\license\license.dat"
-1 "C:\Program Files\MVTec\HALCON\license\license.log"
-e "C:\Program Files\MVTec\HALCON\FLEX1m\i586-nt4\1lmgrd.exe"

The quotes are necessary to handle paths that contain bileekise one above properly.

To check whether the installation succeeded, (re-)opewihdows dialog showing the state of
the installed services (see above), which now should comit& entryHALCON Licenses (Of,

to be more exact, an entry with the name you specified with pii@-n or FLEX1m license
manager If you leave out this option).

After the installation, the daemon is not started autoradiyicIf you have administrator privi-
leges, you can start it directly in the dialog by selectingnt then clicking the start button or
icon; if this fails, please check whether the entries in therise file are correct. The license
manager daemon is started automatically whenever you et the computer.

Note that if you installed the license manager daemon manualu must also uninstall it
manually before you uninstall HALCON, otherwise it remaiinstalled.

Uninstalling the License Manager Daemon
Please note that for the following procedure you need adwnator privileges.

Before you can uninstall the license manager daemon, youfiraistop it: Open the Windows
dialog showing the state of the installed services (seegbsglect the entiyALCON Licenses
and then click the stop button or icon. Note that under Wingla@00 and Windows XP an error
message may appear, which can safely be ignored.

Now, open a Windows Command Prompt, change into the dingctor
J%HALCONROOT%\FLEX1m\i586-nt4, and type:

installs -r -n "HALCON Licenses"

To check whether the uninstallation succeeded, re-opesehaces dialog, which should not
contain an entrylALCON Licenses anymore.

2.3.4.2 Installing the License Manager Daemon Under UNIX

On UNIX systems, the license manager daemagrd must be started from the appro-
priate startup file (called e.g./etc/init.d/boot.local, /sbin/init.d/boot.local,
/etc/rc.boot, /etc/rc.local, or /etc/localrc, please consult your system’s documenta-
tion). Add the following (long) line to this file (with suitd path tolmgrd):

/etc/lmgrd -c $HALCONROOT/license/license.dat
> $HALCONROOT/license/license.log 2>&1 &

where$HALCONROOT is the HALCON base directory you have chosen during the lilasian.
Please note, thaimgrd will only work properly when started withoot privileges!
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2.3.4.3 Restarting the License Manager Daemon

Whenever you replace a floating license or modify it, you nrastart the license manager
daemon. One possible method is to reboot the computer aasintje license server. If you
have administrator privileges, you can also restart thend@emanually. On Windows systems,
open the dialog showing the state of the installed servid@sdows NT:Start > Settings

> Control Panel > Services, Windows 2000 and Windows XPStart > Settings

> Control Panel > Administrative Tools > Component Services > Services), se-
lect the entryHALCON Licenses and then stop and start it again.

On UNIX systems, you stop the proceisgrd and then restart it with the line used in the
startup file (sesection 2.3.4.2

Another reason for restarting the license manager daemwhes you update to a HALCON
release that uses with a newer version of the FLEXIm licenasager software, e.g., from
HALCON 6.1.1t06.1.2 or 6.1.3.

2.3.5 Using a Dongle

Let’s take a closer look at hardware dongles. As already imaad, you can use dongles for
licensing only under Windows NT/2000/XP. From version B.6n, HALCON supports not
only dongles connected to the parallel port but also USB sndpongles for the parallel port
have IDs starting with FLEXID=6- or *FLEXID=7-’, while USB dongles have IDs starting
with *FLEXID=9-’. Please note that you cannot use any dongle but only thos#iedi by
MVTec via your distributor.

2.3.5.1 Dongles for the Parallel Port

As described irsection 2.1.1you can let HALCON install the driver programs necessary fo
using dongles. You can check the success of this installatithe following system dialog,
which should contain an entry call€dntinel.

e Windows NT : Start > Settings > Control Panel > Devices.

e Windows 2000, Windows XP: Start > Programs > Accessories > System Tools
> System Info > Software Environment, then selecDrivers under Windows 2000
or System Drivers under Windows XP, respectively.

You can install, configure, and uninstall the dongle drivanonally using an auxiliary program
which is part of each HALCON installation. Open a Windows @oamd Prompt or the dialog
Start > Run and start the program

%HALCONROOTY\FLEX1m\i586-nt4\flexid6-7\win_nt\setupx86.exe

To install the driver, select the menu iteéfanctions > Install. Afterwards, reboot your
computer. Then, the driver should appear in the dialog destabove Please note, that you
need administrator privileges to install the driver! If you try to install the driver without ad-
ministrator privileges, the setup program might falsestesthat the installation was successful.
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You might need to configure the driver if your computer hasartban one parallel port.

Note that the HALCON uninstallation process does not ualhshe dongle driver as it
might also be used by another application. The uninstalatemoves the auxiliary pro-
gram, though. Therefore, if you want to uninstall the drivdo so before uninstalling
HALCON; of course, the program can still be found on the HAUIC@D in the directory
FLEX1m\i1586-nt4\flexid6-7\win_nt.

Special Information for HALCON 6.0.2

As already mentioned isections 2.1.2nd2.2.1, you must pay special attention to the dongle
driver when installing HALCON 6.0.2. We recommend the faliog procedure:

e Uninstall the old driver manually; the corresponding aiaxyl programsetupx86 . exe
can be found in the directoffHALCONROOT%\FLEX1m\1586-nt4\dongle.

e Now there are two ways to install HALCON 6.0.2:

e Uninstall your old HALCON version as describedsection 2.2.1then install HAL-
CON 6.0.2 together with the new dongle driver as describegation 2.1.1

e Use the update mechanism describedention 2.1.3in this case you must install
the dongle driver manually afterwards with the auxiliarpgnamsetupx86. exe
located in the director HALCONROOT%\FLEX1m\1586-nt4\flexid6-7\win_nt.

If you uninstalled HALCON before uninstalling the old driyeghe corresponding auxiliary
program will be removed! You can recover it from a HALCON 6.® @n the directory
FLEX1m\i586-nt4\dongle); if you don't have a CD, we recommend to install your old HAL-
CON version again.

2.3.5.2 Dongles for the USB Port

As described irsection 2.1.1you can let HALCON install the driver programs necessary fo
using dongles.  You can check the success of this instail@ioche system dialog given in
section 2.3.5.lwhich should contain two entries callg@drdlock andHASP (or similar).

Depending on your operating system, you can install, cordgigand uninstall the dongle
drivers manually using an auxiliary program which is parteaich HALCON installation.
Open a Windows Command Prompt or the diakgrt > Run and execute the program
JHALCONROOTZ%\FLEX1m\1586-nt4\flexid9\hinstall.exe in one of the following ways:

hinstall opens a dialog explaining how to use hinstall
hinstall -info shows the status of the drivers

hinstall -i installs the drivers

hinstall -remove removes the drivers

Please note that you need administrator privileges to instathe drivers!

Note that the HALCON uninstallation process does not uaihtte driver as they might also be
used by another application. The uninstallation removestkxiliary program, though. There-
fore, if you want to uninstall the drivers, do so before utafi;yg HALCON; of course, the
program can still be found on the HALCON CD in the direct8nEX1m\i586-nt4\flexid9.
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2.4 Configuration

Most of the configuration necessary to work with HALCON amisuio setting environment
variables, e.g., to tell HALCON the directories where to fiméges or extension packages etc.
These environment variables are described below. To waitk Rarallel HALCON, you need
to initialize it once on each computer it is to be used on. Thdescribed irsection 5.1.1

2.4.1 Configuring HALCON Under Windows NT/2000/XP

The installation programSetup.exe automatically sets the necessary environment variables,
e.g., »HALCONROOT?%, %HALCONIMAGESY, and?HALCONEXTENSIONSY (see below). To take a
look at these setting, open the dial®gart > Settings > Control Panel > System and
selectEnvironment. You can add or modify a variable by entering the name of aatbéei
and the desired value. If a value consists of multiple iteasse.g. the variablPATHY, which

may contain multiple directories, those items must be sgpdrbysemicolons Please note
that in order to modify variables set during the HALCON iristion you need administrator
privileges!

e HALCONROOT
This is the most important environment variable. It desigaghe directory, where HAL-
CON is installed. A typical path is, for example; \Program Files\MVTec\HALCON.
According to this variable, the system switches to subtiees, which are important
for running HALCON. Some of them are listed below; the HALCGiN structure is
described irsection 2.1.4

- %HALCONROOT%\help
The operator data base is situated in this directory. It¢cessible by all HALCON
programs to obtain information about HALCON operators.

- J%HALCONROQOT%\doc\html\reference\hdevelop
HDevelop uses this directory for online help which can bgldiged by a suitable
HTML browser like Netscape Communicator.

- %HALCONROOT%\license
This directory contains the license file necessary for usiAg CON.

- %HALCONROOT%\images
If the variableHALCONIMAGES (see below) is not set the system looks for image files
in this directory.

e HALCONIMAGES
To search for image files specified by a relative path, theegystses this environment
variable. As a rule it contains several directory namessipdsincluding the CD ROM,
separated by semicolons.

e ARCHITECTURE
HALCON uses this variable to differentiate between the suigal platforms (operating
systems). On a Windows NT/2000/XP systefaRCHITECTUREY, is set t0i586-nt4.
The variable appears in different directory paths: Exdadet&’l ALCON programs, e.g.
hdevelop.exe, and DLLS, e.ghalcon.d11, reside in%HALCONROOT%\bin\i586-nt4.
During installation, this path is automatically added te émvironment variablPATH (see
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below). The libraries which you need for linking programg,. @alcon.1ib reside in the
directory,HALCONROOT%\1ib\i586-ntA4.

e HALCONEXTENSIONS
This is a list of directories in which user-defined extensiperators (so-called exten-
sion packages) are kept. Each package consists of a numlogreddtors linked into
a shared library, plus the additional operator documesrtain help-files and HTML
files. Seesection 2.5for information on how to install an extension package, and
the Extension Package Programmer’s Maniaaldetails on creating your own extension
packages.

e HALCONSPY
If this environment variable is defined (regardless of the&)xbefore you stara HAL-
CON program, the HALCON debugging tool HALCON Spy is actet This corre-
sponds to call the HALCON operateet_spy with the parametersmode", "on" withina
HALCON program. The main difference between the two modeadtivating HALCON
Spy is that by definingHALCONSPY?Y, it is possible to monitor an already linked HALCON
program during runtime without modifications. For furthefarmation on how to use
HALCON Spy and how to parameterize it via this environmenialge please refer to
section 6.4

e PATH
During the installation, the directories;HALCONROOT’\bin\i586-nt4 and
%HALCONROOT%\FLEX1m\1586-nt4 are automatically added to the system variable
PATH.

Please take a look at the fitelease notes.html within the HALCON package for the latest
information.

2.4.2 Configuring HALCON Under UNIX

Under UNIX, different shells offer different commands ta smvironment variables, e.g.,
setenv <variable> <value> O export <variable>=<value>. Please consult your
shell’s documentation for further information. If a valuensists of multiple items, those items
must be separated lzplons

Below, you find a list of environment variables used by the KRN library and by HDe-
velop. We recommend to set them ilogin scriptor ashell resource scripte.g., . cshrc or
.profile):

Examples for entries incshrc
setenv HALCONROOT /usr/local/halcon
setenv ARCHITECTURE 1586-1inux2.2
setenv PATH ... :$HALCONROOT/bin/$ARCHITECTURE/: . ..
setenv LD_LIBRARY_PATH ...:$HALCONROOT/1ib/$ARCHITECTURE/: ...
setenv HALCONIMAGES $HALCONROOT/images

e HALCONROOT
This is the most important environment variable. It desigaghe directory, where HAL-
CON is installed. Typical paths are, for examplesr/local/halcon Or /usr/halcon.
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ARCHITECTURE Operating System (Platform) Compiler
i586-1inux2.2 ) ) ) gcc 2.95

, , Linux 2.2/2.4 on Intel Pentium (or compatible)
i686-1inux2.2-gcc32 gcc 3.2/3.3
sparc-sun-solaris7 | Solaris 7 on Sparc Workstations cc
mips-sgi-irix6.5 IRIX 6.5 on SGI Workstations (Mips processorsiC
alpha-compag-osf5.1 | Tru64 UNIX 5.1° on Alpha processors cXX

Table 2.1: Values of ARCHITECTURE for the currently supported UNIX platforms.

According to this variable the system switches to subdimées, which are important for
running HALCON. Some of them are listed below; the HALCON #leucture is de-
scribed insection 2.1.4

- $HALCONROOT/help
The operator data base is situated in this directory. Iteessble by all HALCON
programs to obtain information about HALCON operators.

- $HALCONROOT/doc/html/reference/hdevelop
HDevelop uses this directory for online help which can bgldiged by a suitable
HTML browser like Netscape.

- $HALCONROOT/license
This directory contains the license file necessary for usiA CON.

- $HALCONROOT/images
If the variableHALCONIMAGES (see below) is not set the system looks for image files
in this directory.

e HALCONIMAGES
To search for image files specified by a relative path, theegysises this environment
variable. As a rule it contains several directory names regpad by colons on UNIX
systems.

e ARCHITECTURE

This variable designates the used platform by an abbrewigi.g., 1586-1inux2.2
or sparc-sun-solaris7; itS syntax is:processothardwarevendoroperatingsystem
ARCHITECTURE appears in several directory paths: Executable HALCON nanog, €.g.
hdevelop, reside iN$HALCONROOT/bin/$ARCHITECTURE. It is therefore useful to in-
clude the pati$HALCONROOT/bin/$ARCHITECTURE in the environment variabATH of a
shell script. Shared libraries reside in the direct$f#yLCONROOT/1ib/$ARCHITECTURE.
Table 2.1gives an overview of the currently supported UNIX platforared the corre-
sponding values ofRCHITECTURE.

e PATH
If you want to start HDevelop from an arbitrary directoryuymust include the HALCON
program pati$HALCONROOT/bin/$ARCHITECTURE in the system variablPATH.

e LD _LIBRARY_PATH
Please include the HALCON library pa$HALCONROOT/1ib/$ARCHITECTURE in the sys-

Spreviously called DIGITAL UNIX
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tem variable.D_LIBRARY_PATH. This is necessary both for running HDevelop and for cre-
ating stand-alone applications.

e HALCONEXTENSIONS
This is a list of directories in which user-defined extensoperators (so-called exten-
sion packages) are kept. Each package consists of a numlogreadtors linked into
a shared library, plus the additional operator documesrtain help-files and HTML
files. Seesection 2.5for information on how to install an extension package, and
the Extension Package Programmer’s Maniaaldetails on creating your own extension
packages.

e HALCONSPY
If this environment variable is defined (regardless of the&)xbefore you stara HAL-
CON program, the HALCON debugging tool HALCON Spy is actet This corre-
sponds to call the HALCON operateet_spy with the parametersmode", "on" withina
HALCON program. The main difference between the two modeadtivating HALCON
Spy is that by definingHALCONSPY?Y, it is possible to monitor an already linked HALCON
program during runtime without modifications. For furthefarmation on how to use
HALCON Spy and how to parameterize it via this environmenialge please refer to
section 6.4

e DISPLAY
The system uses this environment variable to open windawsuted in the same way as
for other X applications.

e HOME
This system variable points to your home directory. In ReraHALCON 6.0
beta, the operatotheck par hw potential which initializes Parallel HALCON (see
section 5.1.] saved the extracted information about the host computethé file
$HOME/ .halcon_par_info .

2.5 Integrating a HALCON Extension Package

The HALCON Extension Package Interface allows to integnately developed image process-
ing algorithms into HALCON in the form of so-callezktension packaged he same mecha-
nism is used by MVTec to extend the current HALCON releasé& wadditional functionality.
Which extensions packages are currently available can bekeld by selecting HDevelop’s
menu entryHelp > HALCON News (WWW), which connects to MVTec's WWW server.

This section describes how to integrate a (downloaded)gggekn order to use it within your
HALCON system.

2.5.1 Installing an Extension Package

First, move the package to the directdiyALCONROOT% and unpack it there. Then, add the
completepath of the package, e.g.,

JHALCONROOT?\packages\halconuser
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to the environment variabl@ALCONEXTENSIONS. Note, that the delimiter between paths in an
environment variable is a semicolon on Windows systems aradicsm on UNIX systems.

Never change the name of a package or the corresponding namesthe li-
braries or DLLs contained in a package.

These names are encodeithin the libraries/DLLs. If you change the names this informatio
will not match any longer. Thus, the loader of the operatysiem will fail to open the dynamic
libraries.

If the package contains images used, e.g., within exammggrams you might want to in-
clude the corresponding directotynages within the package in the environment variable
HALCONIMAGES (seesection 2.4to access those images without specifying a complete path.

2.5.2 Using an Extension Package Within HDevelop

In order to use a new package within HDevelop under Window&BJ0/XP, Solaris, IRIX, or
Tru64 UNIX/ DIGITAL UNIX, you just have torestart the program. HDevelop automatically
integrates all extension packages specifieilnCONEXTENSIONS, i.e., the operators contained
in a package can be accessed and used like any other HALCQOhbltope

Under Linux, you have to include the package library sulmdo®/ 1ib/i586-1inux2.2
(or 1ib/i586-1inux2.2-gcc32 if you are usinggcc 3.2/3.3) in the environment variable
LD_LIBRARY_PATH before starting HDevelop the first time.

2.5.3 Using an Extension Package in a Stand-Alone Applicati  on

If you want to generate a stand-alone application using #o&gge you have to link package
libraries (DLLs under Windows, shared libraries under UNtXthe application code (besides
the standard HALCON library, of course).

2.5.3.1 Using an Extension Package Under Windows NT/2000/X P

In order to create new application programs (written in C of+Cyou have to link
packagec.lib Orpackagecpp.lib to your objects. Furthermore, you will nekalconc.1ib
orhalconcpp.lib (as for any HALCON application).

To be able to link the package DLL to your application progrémecompleteDLL file path of
the new package, e.g.,

%HALCONROOT%\packages\halconuser\bin\i586-nt4
has to be added to the environment varictieH.

Do not copy a package DLL into the Windows system directoriesas it would be loaded
twice in this case!
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2.5.3.2 Using an Extension Package Under Linux

In order to create new application programs (written in C or+LCyou have to link
libpackage.so and libpackagec.so Or libpackagecpp.so t0o your objects (besides
libhalcon.so andlibhalconc.so Or libhalconcpp.so as for any HALCON application).

Furthermore, you have to add the package library subdimgctob/i586-1inux2.2 (Or
1ib/i586-1inux2.2-gcc32 if you are usinggcc 3.2/3.3) to the environment variable
LD_LIBRARY_PATH, otherwise the loader will fail to access the libraries.

2.5.3.3 Using an Extension Package Under Solaris

In order to create new application programs (written in C of+Cyou have to link
libpackage.so and libpackagec.so Or libpackagecpp.so to your objects (besides
libhalcon.so andlibhalconc.so Or libhalconcpp.so as for any HALCON application).

Furthermore, you have to add the package library subdimedttb/sparc-sun-solaris7
to the environment variableD_LIBRARY_PATH, otherwise the loader will fail to access the li-
braries.

2.5.3.4 Using an Extension Package Under IRIX

In order to create new application programs (written in C of+Cyou have to link
libpackage.so and libpackagec.so Or libpackagecpp.so t0 your objects (besides
libhalcon.so andlibhalconc.so Or libhalconcpp.so as for any HALCON application).

Furthermore, you have to add the package library subdimgttd/mips-sgi-irix6.5 to the
environment variabl@D_LIBRARY_PATH, otherwise the loader will fail to access the libraries.

2.5.3.5 Using an Extension Package Under Tru64 UNIX (DIGITA L UNIX)

In order to create new application programs (written in C or+LCyou have to link
libpackage.so and libpackagec.so Or libpackagecpp.so to your objects (besides
libhalcon.so andlibhalconc.so Or libhalconcpp.so as for any HALCON application).

Furthermore, you have to add the package library subdingdtib/alpha-compag-osf5.1
to the environment variableED_LIBRARY_PATH, otherwise the loader will fail to access the li-
braries.
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Chapter 3

A First Look at HDevelop

In this chapter you will learn how to solve an image analysabfem from the scratch. Dur-
ing an example session, the most important features of HDe\ae going to be introduced.
You will become familiar with HDevelop'graphical user interface (GUland learn to use it
efficiently.

The example is chosen from the domain of quality control. {bal is to detect all ball
bondingson adie, seefigure 3.1 The HDevelop program corresponding to the example session
is included in the HALCON package subdirectory:

%HALCONROOT%\examples\hdevelop\Manuals\GettingStarted\example.dev
In particular it will be shown

e how to construct a HDevelop program with HALCON operators,
¢ how to find suitable operators and parameter values,

¢ how to handle iconic and control variables,

e how to handle the graphics window,

e how to generate a region of interest (ROI),

e how to solve the example problem using morphology,

e how to solve the example problem by pattern matching, and

e how to use control constructs.

Read this chapter very carefully and you will understandodigc interactive features of HDe-
velop. This will help you to develop your own sophisticatethge analysis programs in the
future.
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Figure 3.1: The image to be analyzed: All ball bondings on a die have to be detected.

3.1 The Graphical User Interface of HDevelop

You start HDevelop under Windows NT/2000/XP by calling
Start > Programs > MVTec HALCON > HDevelop

Under UNIX, HDevelop is started from the shell by calling
hdevelop

Having started HDevelop, th@ain windowwill appear on your screen. It contains féuvin-
dows (sedigure 3.9

e a program window,
e an operator window,
e avariable window, and

e a graphics window.

In the following, the HDevelop windows will be explained &ity. For more details see the
HDevelop User’s Manual.

3.1.1 Main window

Themain windowis the central window and the starting point for your workcdmprises the
creation of a HDevelop program (operator selection, eglitatc.) and the session management
(loading, saving, etc.). This main window is identified b title 'HDevelop’ in the window’s
title bar. It also contains menu barand atool bar.

Please note that in the UNIX environment the main window,gteggram window, and the operator window
are combined into one window. Thus, there are dhigewindows.
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i HDevelop M[=] E3

File Edit Egecute “izualization Operaforz Suggestions  “Window  Help
D| (=] & [Bae] | Z=EE] EbelE B Bl m el
TR T

il Operator -

op i Waniable Watch =] E3
| =2 i Graphicz Window =] E=

Clear | Active [ |

Col
-
3

Figure 3.2: The main window.

e Main window menus
In these menus you will find the complete HDevelop functigpalvhich is summarized
in the following table. For more detailed information see HDevelop User’'s Manual.

Menu Contains Commands for:
File Loading and saving of HDevelop programs and exit-
ing HDevelop
Edit Editing a HDevelop program
Execute Running a HDevelop program

Visualization| Customizing the graphics windows and handling their
output behaviour

Operators Submenus containing programming constructs, HDe-
velop operators, and all HALCON operators

Suggestions | Support choosing an operator
Window Window management
Help Opening online documentation and guides

e Main window tool bar
This tool bar offers shortcuts for frequently used comma#mdsthermore, it provides the
means to control the execution of an HDevelop program.
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Button Performs this Operation:
New Deletes the current program in the program window
Open Opens a new HDevelop program
Save Saves a HDevelop program
Cut Deletes program lines selected in the program window
Copy Copies program lines selected in the program window
Paste Inserts copied lines in the program window
Run Executes the HDevelop program
Step Executes the next command of the HDevelop program
Stop Stops the running HDevelop program
Activate Activates the lines selected in the program
Deactivate Deactivates the lines selected in the program
Reset Resets the program into its initial state and clears alkdeis
Set parameters Opens the visualization parameter dialog window
Gray value inspection Opens the window for gray value inspection
Zooming Opens the online zooming window
Gray value histogram Opens the interactive gray value histogram
Feature histogram | Opens the interactive region/XLD feature histogram
Region inspection Opens the interactive region feature inspection window

3.1.2 Program Window

This window is used to display a HDevelop program. This miggtan entire program, which
has been loaded, or single operators only. It has two pans:|&ft area contains marks which
control the running of a HDevelop program. In the initial H2ep state you will see the
program countePC), represented by a green arrow, anditisertion cursorrepresented by a
>>. Additionally you may set &#reak pointduring program debugging (see the user HDevelop
User’s Manual for a detailed explanation). The right areg@os the program code. It is empty
in the initial state.

3.1.3 Operator Window

This window will show you important information about a ckasoperator. It indicates all
parameter names, their types, and their values. It suppoutén specifying a parameter value
by displaying a default value and alternative values. Adddlly, you may get online help for
each operator.

Another window element is the text field. If you are not quiteesabout an operator name
you may specify a substring in this text field. In this case,giistem is going to search for all
operators in its operator base which include this substiiingy are displayed in @mbo box
where you may choose the appropriate operator.

3.1.4 Variable Window

This is the control unit for variables generated during tkecetion of the program. Double-
click on a variable to display its value. If the variable @sponds to an image or a set of regions
(iconic variablg, the contained objects are displayed in the Graphics Windo
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3.1.5 Graphics Window

This window is used to display iconic variables. The viszation modes can be adapted to your
needs with the functions provided in thiésualization menu. You may open an arbitrary
number of graphics windows. Each window can be activatestactively or accessed using its
specific window ID.

3.2 Editing a HDevelop Program

After starting HDevelop, the tool waits for your input. Yoreate an application, in other words,
write your HDevelop program, by adding lines in the Prograimmdw. To add a new liné,
i.e., a new operator, you have to perform two steps:

¢ Position thansertion cursorn> on the appropriate line of the program where you would
like to insert the new line. This cursor is placed by pressitexShift> button on your
keyboard and clicking in the left column beside of the progtae with the left mouse
button.

e Select the new operator using thgerator menu or type its name in the operator win-
dow’s text field.

Now the new operator is displayed in the operator windowvideor adapt the input parame-
ters and — if desired — change the names of the output vasableen clickEnter to insert
the operator as a new program line. If you click@ninstead, the operator is not only inserted,
but also executed immediately. Finally, if you click apply the operator is not inserted into
the program, but only executed. This allows you to test tiiecebf your parameter settings
very quickly and conveniently.

To execute an arbitrary line of a HALCON program you have tsifpan the program counter
(PC) at this line (just click at the left column beside thee)inThen press thétep icon in the
main window tool bar. If you presiun instead all subsequent lines will be executed until a
breakpoint or astop command is encountered. A single-click on a program linectelthis
line, a double-click transfers the line back to the operatodow.

Once you have finished the program you can save it and loadiih &ger, or you might export
itas C, C++, or COM code to generate a standalone applicgde®¥ile > Save as...).

These basic steps will be used many times during the exarapstos. So you will have many
opportunities to get used to the different methods of eglipnogram, specifying parameter
values, etc. For now, just continue with applying your fingsemtor to read an image.

3.3 Loading an Image

First of all, you have to create a HALCON object that contajosr input image You may
obtain an image in several ways:

2The commandsopy, Cut, andPaste, which are also very convenient to edit a HDevelop prograith be
explained later during this session.
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i Program I [=] S
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i Dperator
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Figure 3.3: Setting the parameters of the operator read_image.

e You can use a frame grabber to obtain an online image (see mm@mwperators >
Image > Framegrabber).

e You canread an image from a file (see menu i®@®@rators > File > Images and menu
itemFile > Read image...).

e You can create a new image (see menu ii@@rators > Image > Creation).

In the example we will use theead_image operator. Just seleetad_image in the submenu
Operators > File > Images Of typeread_image in the operator window's text field and press
Enter. Now the operator should be displayed in the operator wind®mefigure 3.3 The

first parameter is th@nage objectyou are about to create. Change the default name of the
corresponding variable to 'Die’. You get a text field focus ddicking the left mouse button
inside the desired text field. The second parameter is the mditine image file. Change it to
'die3’:

read_image (Die,’die3’)

Having specified all parameters you should priasw transfer the operator to tipgogram win-
dowand to execute it. Now you have created the first line of yoagmm in theprogram win-
dow. The variablebie containing the image object you just created is displayadawariable
window Simultaneously, the result of the operator (in this caseotiginal image) is displayed
in thegraphics window If you encounter an error trying to load the image, checktivieyour
environment is set up correctly. The image should be lodatédALCONROOT?,\ images which

is also the default search path for image files as long as yowdorovide specific search paths
in theHALCONIMAGES variable, sesection 2.4
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3.4 Modifying the Graphics Window

The size of the initial graphics window is 522512 pixels. If your image is bigger or smaller
than this size it will therefore be displayed distortedlypuYcan interactively change the win-
dow size just by picking the lower right corner with the mauset the easiest way to see the
undistorted image is to sele¢isualization > Size Window > Original. This enlarges or
shrinks the window to the size of the most recently displayealge. However, in this exam-
ple we are going to open a new window with the proper size srae will need its window
handle later on. Again, there is a interactive way to do the®(menwWisualization), but we
will use the HDevelop operatatev_open _window instead to include this task in the program
itself. HDevelop operators are handled in the same way asG{3\ operators. You can access
them via the menOperators > HDevelop or directly via theoperator window’stext field.
The parameteWidth andHeight specify the size of the window. If you do not know the size
of the current image you just specify -1’ for both paramstdn that case the size of the most
recently created image will be used.

dev_open_window (0,0,-1,-1,’black’,WindowID)

Click on 0k and a newgraphics windowappears. It has the same size as your image. But the
new graphics display remains dark. It is now #etive graphics windovand waits for your
input. It is up to you what to display in this window. Doublke& on theiconic variableDie

in thevariable windowby using the left mouse button in order to display this imagew you

see the input image without distortion, degure 3.1

The default visualization for an image is to display the imagatrix, i.e., the gray (or color)
value of each pixel. You can easily switch to other visuagiomamodes vidVisualization
> Set parameters... > paint. Choose for example '3D-plot’ and selégjidate to see a
3D plot of the image. The various visualization modes arerilesd in detail in the HDevelop
Users Manual. Do not forget to change the mode back to 'défaefore continuing with the
example session. All the visualization modes can be modaigdn your program as well: For
example, the display of the histogram is activatediby_set_paint (’3D-plot’). See also
section 3.50 learn how to manipulate the visualization of regions.

Furthermore, it is possible to zoom into the image. Justs#he menu itenVisualization

> Set parameters... > zoom. Click on the uppefnteractive... button. Now you can
specify a rectangle within your graphics window. To do thisiypress the left mouse button to
indicate the upper left corner. Keep the button pressed eagl ttie mouse to the lower right
corner of the desired rectangle. Release the left buttorchekithe right button once. Now
you have specified the image part you are interested in. Allalizations are how zoomed to
this image part. This is the interactive way to set an image paother possibility is the direct
input of the coordinates of the image part (ilsualization > Set parameters... > zoom

or to use the HDevelop operataev_set_part). To visualize the whole image again, click
Reset in Visualization > Set parameters... > zoom.

3.5 Creating a Region of Interest (ROI)

Very often it is useful to specify an ROI which is used in thidaing processing steps. By re-
stricting the image domain the performance can be incresigadicantly because all following

HALCON 6.1.4



42 CHAPTER 3. A FIRST LOOK AT HDEVELOP

image processing tasks will be performed only within this R@d not on the whole image.

Figure 3.4: A rectangular and an arbitrary region of interest (ROI).

To generate a ROI you have the following possibilities:

e Interactive creation of a rectangular ROI:
Select the operat@raw_rectanglel from the menwWperators > Graphics > Drawing
to draw a rectangle in thgraphics window Just execute the operator with the default
names for the output variables (containing the pixel cowtdis of the upper left and
lower right corner of the rectangle). This creates a newilinthe program windowand
HDevelop waits for you to draw the rectangle (like you diddrefwhile setting an image
part to zoom in). After you finished the drawing, the four gohbutput variable®ow1,
Columni, Row2, andColumn2 will appear in thevariable window seefigure 3.5 To gen-
erate the corresponding ROI as an HALCON object, use theatppgfen rectanglel
from the menwperator > Regions > Creation with the variableRowl — Column?2
as input parameters. You might use 'ROI’ as the name for theltiag output object:

draw_rectanglel (WindowID, Rowl, Columnl, Row2, Column2)
gen_rectanglel (ROI, Rowl, Columnl, Row2, Column2)

By executing this operator you create another type of HALCOIject — a region, see
section 4.2.3

i Yariable Watch M=l &3

Iconic Yatiahles:

Cortral Variahles:

WindowHandle: 3604
Rowl: 974
Colurant: 2955
Row: 385.5
Column2: BES.5

4| | »

Figure 3.5: The variable window containing iconic and control variables.
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The default visualization for a region is the shape of theore¢here the rectangle) drawn
with the current color into thgraphics window You may manipulate this graphics out-
put by choosing items of the mefltisualization or executing the corresponding HDe-
velop operatodev_*. For example, set the drawing color to 'green’ wittsualization

> Color, increase the line with for drawing to 3 pixels withsualization > Line
Width and specify, that only the region boundary (‘'margin’) ir&tef the whole region
(fill") should be displayed withvisualization > Draw. Each time you change the visu-
alization, the last iconic object that was drawn into the-ently active graphics window
is redisplayedf{gure 3.4. Therefore, you need only redisplay an object by hand (by
double-clicking it in thevariables windowf you want to change the display mode of an
“older” object.

e Interactive creation of an arbitrary ROI:
HALCON supports arbitrary regions as ROI, Sgpire 3.4 Just uselraw_region from
the menwperators > Graphics > Drawing instead of the sequendeaw_rectanglel
andgen_rectanglel:

draw_region (ROI, WindowID)

To adapt the program in this way, you may select the dinew_rectanglel (just click
on that line) and deactivate it withdit > Deactivate. Do the same with the line
gen rectanglel.

e Computation of a suitable ROI:
The computation of a suitable ROI based on intermediatdtsesithe image analysis is
the most challenging but also the most flexible approach.utresample we will detect
the board itself and use this as a ROI for the ball detectiemsaction 3.8

Once you have generated a ROI you can reduce the image damtais tegion with the oper-
atorreduce_domain from Operators > Image > Domain. SpecifyDie as inputimage ang0I
as input region:

reduce_domain (Die, ROI, ImageReduced)
mean_image (ImageReduced, ImageMean, 11, 11)

The resulting imagdmageReduced is only defined within the ROI. Clear the window and
double-click on the variabl&@mageReduced to see this effect. You might apply a couple of
operators to the original image and the reduced image tcheel@drease in performance. For
example, trynean_image from Operators > Filter > Smoothing with Die as input image.
Then clear the window and double-click on thean_image program line to change the input
image toImageReduced.

To repeat the above sequence with different ROIs just plag@d on draw_rectanglel or
draw_region (depending on which method you have activated) and @ssin order to stop
the execution of the program before a specific operator iseapplace areak point(BP) in
the program line containing this operatépfitrol key and mouse click in the left column).
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3.6 Finding the Right Operator

You have created your first HALCON object — the original imaBet how to continue? There
are about 1000 operators to choose from. Naturally, theteteof a suitable operator sequence
depends on the image analysis task you have to solve. Ina@eiigs up to your experience
and image analysis knowledge to make the right selectiomesder, HDevelop supports you in
many ways during this program development.

The HALCON operators are hierarchically structured. Justise theDperators menu to get
a first impression.

i Dperator H=1
Operstar: [thresh| d
auto_threshold
hin_threshold -
char_threshold ¥ | (mage / object)
dual_threshold
dyn_threshold - | (region / ohject)
fast_threshold
hls‘to_m_.thrash | number £ real)
hysteresis_threshold
threshold
threshold_sub_pix )| (s A=)
(o713 I Eriter Apply | Cancel | Helg |
=
) | ]

Figure 3.6: Selecting the threshold operator using the substring “thresh”.

Again, if you already know at least a substring of the operatome you might also just type
this string in theoperator windovis text field. If there is an ambiguity, you choose the opearato
inside thecombo boxseefigure 3.6

For each HALCON operator HDevelomsline helpprovides an HTML description. Just select
Help > HTML. .. to start your default browser. You will see the table of cotgeof all image
analysis modules — structured in the same way affleegators menu. Simply select an
appropriate chapter and continue browsing until you findryaperator. There are also many
cross references according to the relationships betweeoghrators. At the end of the main
page there is an index of all operators, which helps you tgjdirectly to a specific operator
HTML page.

Furthermore, the mensuggestions > Keywords offers access to HALCON operators by
keywords By selecting this menu item, a window is displayed with tlailable keywords on
the left side and the operators related to the selected kelgnm the right side. If you select
a keyword using your mouse you will see the correspondingatpes in the right area. Each
mouse click in the left area marks the keyword and adds soramtips in the right area. To
finally select an operator and display it in tbperator windowust click on the operator name
using your left mouse button.

Once you have selected one of the operators fé«l_image in our example, you can enquire
information related to this operator from tbperator knowledge base

e The HTML online help.
Just click on thélelp button to launch your default web browser and get the coraplet
online documentation of the selected operator.
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e Suggestions > Alternatives
If an intermediate result does not fulfill your requiremeys might want to choose an
alternative operator which might be more suitable for yaskt Note, that in many situ-
ations there is a trade off between performance and accofdbg results. For example,
you might use the high performance smoothing fitiesn_image in one situation and the
higher quality smoothing filtergauss_image or smooth_image in another.

e Suggestions > See also
The online help of HDevelop also offers references to othparators, which are not
exactly alternatives, but related to the current operat@ome way. For example, if you
currently look atread_image you might be interested in therite_image operator as
well.

e Suggestions > Predecessor
Many operators require a specific input provided by otheratpes. For example, before
computing junction points in a skeletojufpctions_skeleton), you have to compute
the skeleton itselfdkeleton).

e Suggestions > Successor
On the other hand, there are typical sequences of operatiersce HDevelop suggests
some reasonable operators to be executed following thatmpeou are currently looking
at. For example, thresholding might be a good idea afteryapphn edge filter.

In our example you have just created the input image. Ndythis is a very unspecific sit-
uation with lots of different opportunities to continue. \ever, we will accept one of the
successor suggestions, tttereshold operator later on.

3.7 Finding the Right Parameter Values

Once you have selected an operator (from the menu, by typsmgime, or by double-clicking
on a program line in the program window), it is displayed ia ¢iperator window Now you
have to specify the parameters for the operator. Of coulse,cgn type in every parameter
manually (either a control value or a variable name). In meemes it is more convenient to
use thecombo boxegclick on the arrow at the right side of the parameter fieldyead, which
provide a listing of meaningful values or names of varialglas specified within your program.
Furthermore, for control input parameters default valuegpaovided by HDevelop.

For example, apply threshold operatoto the input image by selecting the operatbteshold
from Operators > Segmentation. Specify the input imageie using thecombo box If you
use the default values for the lower and upper thresholgpadls in the input image witigray
valueslarger than 128 will be included in the resulting output cegiTherefore, you could call
the corresponding output varialBeightRegion. It might be helpful to set the visualization
modeVisualization > Draw to 'fill'. In this case you see all the selected image pixelis 1zl
in the current drawing color in thgraphics window Double-click onDie andBrightRegion
again to underlay the visualization of the region with thigioal image, seégure 3.7

To choose another parameter value just double-click on tbgram line containing the cor-
responding operator, change the parameter, and ppgds. The operator will be executed
immediately and its result will be visualized. Repeat thimgess until you are satisfied with the
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Figure 3.7: The region object BrightRegion containing all pixels with gray values larger or
equal 128.

result, then presgk. But remember to clear the window or underlay the originadge before
each new execution of an operator returning a region. Oteerwou only see the accumulated
visualization of all regions you generate during the partam@ning.

3.8 Finding the Board as ROI

Looking at the input imag®ie you will notice that the surface of the board is quite bright.
Thus, by applying thehreshold operator with the default values 128 and 255, a reasonable
raw segmentatioof the board can be achieved. We will now transform this segmentation
into aregion of interestfor the ball detection: Select the HALCON operatifape_trans

with BrightRegion (the result of the thresholding) as input region and 'regla®’ as value

for the parameter 'type’ to obtain themallest rectangl€of arbitrary orientation) containing
BrightRegion. The resulting region (called ‘ROI’) is a reasonable apprwtion of the board

in the image. As irsection 3.5reduce the domain of the original image to this ROI with the
reduce_domain operator:

threshold (Die, BrightRegion, 128, 255)
shape_trans (BrightRegion, ROI, ’rectangle2’)
reduce_domain (Die, ROI, DieROI)

The following computations will be performed only on theukisig imageDieROI within the
board.

3.9 Finding Bonding Balls Using Morphology

If you look closer at your image you will notice that the bamgliballs to detect are darker
than thedie itself. Therefore, anotheéhresholdingmight be suitable as the next operation, see
figure 3.8 Due to noise, the resulting region (all the dark parts withie board) might have
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Figure 3.8: The region object RawSegmentation containing all dark pixels within the board.

some small holes which can obstruct further processingaléontrolled filling up of these arti-
facts, the HALCON operatafill_up_shape (in Operators > Regions > Transformation)
IS suitable.

threshold (DieROI, RawSegmentation, 0, 50)
f£ill_up_shape (RawSegmentation, Wires, ’area’, 1, 100)

Visualize the variablegires andRawSegmentation, then change the drawing color to see the
difference.

Figure 3.9: Removing faulty parts of the raw segmentation with the opening circle operation.

Unfortunately, the region found so far contains not onlylibading balls but also some darker
areas, especially the wires connected to the balls. Oblyiahe bonding balls have a circular
shape. We use this information to separate the bonding fralts the other dark parts by
using the HALCON operataspening_circle (in Operators > Morphology > Region). This
morphological operation will suppress all parts of the eegiwhere the underlying structural
element — a circle with a specific radius — does not fit withia tegion, seégure 3.9
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opening_circle (Wires, BallRegion, 15.5)

Visualize the variableBires andBallRegion, then change the drawing color to see the effect
of this operation.

Now there is only one artifact left in the segmentation: Ag&dark rectangular shape, in
which the circular mask for the opening has fitted as well. riieo to eliminate this error the
intermediate result — the regiddal1lRegion — iS separated into connected regions via the
HALCON operatorconnection:

connection (BallRegion, Balls)

Note the differenceBallRegion iS one region containing all the pixels of the segmentation
so far. The different parts of this region are not connedbeil still they form a single region.
Balls is a variable containing seven separated HALCON objects e@n connected region.
SetVisualization > Colored to 12. Now 12 different colors are used cyclically to pairg th
region objects. It is a very convenient feature of the HALC&)dtem that iconic variables can
contain not only single objects, but also tuples of objettest HALCON operators accept
such tuples as input and perform their task simultanouslglbthe contained objects. Due
to this mechanism you won’t have to program loops to procégscts one by one in most
situations.

Based on the circular shape of balls, the elimination of #&angular region is now very
simple. Just apply theelect_shape operator (inOperators > Regions > Features) with
‘circularity’ as the selection criterion:

select_shape (Balls, FinalBalls, ’circularity’, ’and’, 0.85, 1.0)

Double-click on the variableie, then onFinalBalls to see the selected regions only. Note
again thatBalls contains seven objects, from which you select all circudgions with this
single operator call. Now, the ball segmentation is finishedhe next section it will be shown
how to perform measurements based on the segmentatioh atibefore continuing, recall
how simple it was to detect the balls and handle all the ingéeliate iconic objects generated:

read_image (Die,’die3’)

threshold (Die, BrightRegion, 128, 255)

shape_trans (BrightRegion, ROI, ’rectangle2’)

reduce_domain (Die, ROI, DieROI)

threshold (DieROI, RawSegmentation, 0, 50)

f£ill_up_shape (RawSegmentation, Wires, ’area’, 1, 100)
opening_circle (Wires, BallRegion, 15.5)

connection (BallRegion, Balls)

select_shape (Balls, FinalBalls, ’circularity’, ’and’, 0.85, 1.0)

3.10 Working with Control Variables

So far we have detected the ball bondings within the imagee&an this segmentation we can
now perform some simple measurements. The most obviousunegasnt is to count the balls
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via count_obj (in Operators > Object > Information):

count_obj (FinalBalls, NumBalls)

Similiar to thedraw_rectanglel command irsection 3.5/0u generated a new control variable
calledNumBalls containing the desired number of balls. There are manyrdiiteHALCON
operators computing specific features of regions (§g@&rators > Regions > Features).
Among them, one you might try now &sallest_circle. This operator determines the posi-
tion and radius of the smallest circle containing each impgion:

smallest_circle (FinalBalls, Row, Column, Radius)

Note thatFinalBalls contains six objects. Thus, six circles are calculated —fon@ach

of the input regions. Therefore, the output control vaeaBbw, Column, andRadius do not
contain single values, but tuples of values. Again, no lompstruct is necessary to process all
objects. Tuples of control values are shown in bracketsiwitie variable window. If a tuple
variable contains too many elements to be shown at once ale \ist is truncated and three
dots are added. For inspecting such a tuple, just dould&-ch the variable you want to see
with the left mouse button. A window will be opened contagaill the elements of the tuple.

Figure 3.10: The final result of the ball detection based on morphology.

The further processing of control data is facilitated by dthno formula interpreter. See the
HDevelop User’'s Manual for details. For example, you cowthpute the average value of the
tupleRadius with the following HDevelopassign statement (Se@perator > Control)

assign (meanRadius, sum(Radius) / |Radius|)

which is displayed in the program window as

meanRadius := sum(Radius) / |Radius]|

A more reasonable measurement concerning the qualityatdagk might be the computation
of the minimum area of the balls. This can be achieved by apglthe HALCON operator
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area_center (in Operators > Regions > Features), which calculates the area of each ball,
followed by anothenssign statement:

area_center (FinalBalls, Area, RowCenter, ColCenter)
minArea := min(Area)

Of course, tuples of control values can also be used as irgratpeters. For example, draw
the circles you have computed with the HALCON operaiogp_circle (in Operators >
Graphics > OQutput), seefigure 3.10

disp_circle (WindowID, Row, Column, Radius)

3.11 Finding Bonding Balls Using Pattern Matching

The morphologic approach detected the desired bonding bpkuppressing spurious parts of
the raw segmentation gained by thresholding. In this segtau will encounter a completely
different approach to this detection problem. The patteatciting approach can be divided
into two steps:

1. Creating a so-calle@mplaté (typically during a training phase).

2. Searching for this template in the current image.

Figure 3.11: A template for a ball.

In our example we will create a template containing a singlé o do this, just copy the two
program lines you used to generate a rectangular search eation 3.%.

draw_rectanglel (WindowID, Rowl, Columnl, Row2, Column2)
gen_rectanglel (ROI, Rowl, Columnl, Row2, Column2)

3another word for the pattern that is searched in the image
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To do so, select the two program lines, copy them w&idht > Copy, position the insertion
cursor at the end of the program and sele¢it > Paste. Then, position theeC on the
draw_rectanglel command, presBun and draw a small rectangle containing nothing but
one of the balls, sefgure 3.11

Then copy the program line for reducing the image domainéaéisulting regiom01T:

reduce_domain (Die, ROI, ImageReduced)

Now you can transfornimageReduced, which is the original image restricted to the rectan-
gular domain you just have specified, to a template. This dponéhe HALCON operator
create_template (in Operators > Filter > Match):

create_template (ImageReduced, 5, 4, ’sort’, ’original’, TemplateID)

To obtain the center of the template (which will be needed/femalization purposes later) use
the followingassign statements:

TemplRow := (Rowl + Row2)/2
TemplCol := (Coll + Col2)/2

After the creation of the template you have the choice batvekigerent matching algorithms.
We will use a two-step strategy. First, a fast matching dpera applied to find all image points
where the template might match. In the second step, witldh eluster of such points the exact
position of the template will be determined. The HALCON aqer fast_match (again in
Operator > Filter > Match) delivers the regiomMatches containing all possible matching
positions:

fast_match (Die, Matches, TemplateID, 20)

Double-click on the original imageie and the result regiomatch to see these positions. The
input parametefaxError is set to 20 in this example. There is a trade-off betweeropadnce
and fault tolerance of the matching. Decrease the value atdwthe execution time when
applying the operator. For very small values of the toletaeor some of the balls might be
missed. On the other hand, increasing the value decreaspsittormance significantly.

Besidesfast _match there is also a HALCON operatdust _match mg working on different
resolution levels, which in general increases the perfogeaJust try

fast_match_mg (Die, Matches, TemplateID, 20, 3)

to perform a search with three resolution levels and comierexecution time with the one
resolution method underlyinfast_match.

After we have derived all posible matching positions, weasepose the corresponding region
into connected components:

connection (Matches, BallROI)
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If you specified a reasonable template and a suitédst&rror this should result in six regions
corresponding to the six (fully) visible balls in the image.

count_obj (BallROI, NumBalls)

Within each of the regions iBal1ROI we would like to determine the exact position of the
template. This can be done by another HALCON operator, d¢alést_match.* BallROI
contains only regions. Thus, we have to add an image, thatis\@lues, to the objects prior
to the final matching. This is done with the operaiad_channels (in Operators > Image >
Channel):

add_channels (BallROI, Die, BallImage)
best_match (BallImage, TemplateID, 20, ’true’, Row, Column, Error)

Note that thebest_match operator is applied to all objects containedBiil1Image. Thus,
the control output variablesw andColumn specifying the exact matching position ait-or
containing the matching error should be tuples of valuesviSoalize the results we display
rectangles like the one used for the template generation Htegtby the offset beween the
matching positions and the center of the templatefigeee 3.12

disp_rectanglel (WindowID, Rowl+Row-TemplRow, Columni+Column-TemplCol,
Row2+Row-TemplRow, Column2+Column-TemplCol)

You should make sure that the region visualization is seirargin’ usingVisualization >
draw before executing this command.

Figure 3.12: The final result of the ball detection based on pattern matching.

If you do not need the template any longer, it should be ctearigh the HALCON operator
clear_template. Summarizing, the ball detection using pattern matching d@ne by the
following sequence of HALCON operators:

4Again, there is a multi-grid version of this matching operabut since we already restricted the search to a
very small part of the image, it is not too interesting to bset match mg in this case.
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read_image (Die,’die3’)

draw_rectanglel (WindowID, Rowl, Columnl, Row2, Column2)
gen_rectanglel (ROI, Rowl, Columnl, Row2, Column2)

reduce_domain (Die, ROI, ImageReduced)

create_template (ImageReduced, 5, 4, ’sort’, ’original’, TemplateID)
fast_match_mg (Die, Matches, TemplateID, 20, 3)

connection (Matches, BallROI)

add_channels (BallROI, Die, BallImage)

best_match (BallImage, TemplateID, 20, ’true’, Row, Column, Error)
clear_template (TemplateID)

Note that the check for correct shape and area of each batipBcitly done by the pattern
matching. In the previous approach this was performed bypheing circle operator.

By the way: Program lines that are not needed any more canrbgapently removed. Just
select them (left mouse button) and choB&ét > Delete. Don't be shy — there is aRdit >
Undo as well. To temporarily deactivate a line usgit > Deactivate andEdit > Activate
to activate the line again.
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3.12 Using Control Constructs

HDevelop offers various control statements to construagiencomplicated programs. For a de-
tailed specification see the HDevelop Users Manual. Yowadiydnave encountered thesign
statement in the previous sections. We will now use two otletrol statements —£or and
if — to further improve the example program.

Up to now, all matching positions returned byst _match in section 3.1were used to display

a rectangle. This might lead to undesirable results if thechiag fails for some of the input
objects. Just decreadexError to 5, for example, to see what happens: For each input object
in BallImage which does not contain the template 0 is returned@dn andColumn® and the
maximum average gray value deviation of 255 is returneéttiror.

The correct way to handle these matching errors is to checilfeesulting matching positions
whether they are valid or not. Simultanously, the real nurobdetected balls can be computed:
Initialize a counter with thessign statement

RealNumBalls := O

Then program a loop with the counterand the end valuBumBalls (control statemenfor).
Inside the loop, check the error value of each match and skifpyf matches:

for i := 1 to NumBalls by 1
if (Error[i-1] < 255)
disp_rectanglel (Rowl+Row[i-1]-TemplRow, Columni+Column[i-1]-TemplCol,
Row2+Row[i-1]-TemplRow, Column2+Column[i-1]-TemplCol)
RealNumBalls := RealNumBalls + 1
endif
endfor

Display the original imag®ie again and execute the above loop to see the result.

SA template position which is actually outside of the curranage, becauskow and Column specify the
position of thecenterof the template.
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Chapter 4

Philosophy of HALCON

This chapter explains the basic concepts of the HALCON sysits modular architecture and
its data structures. Furthermore, it describes HALCONiste grabber interface.

4.1 Modular Structure

Applications

Visual

Basic C# Delphi etc.

Language Independent Operator Interface

Frame
grabber

Interface

Image Processing Library Extension
Package

Iconic Data Management Operator Knowledge Base

Figure 4.1: Layered structure of HALCON .

The base of HALCON is thdata managemenmbgether with theperator knowledge basd@he
data managementis reponsible for basic memory manageapimized for image processing)
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and on top of this for the creation, handling, and deletiomcohic objects and tuples. The
knowledge base stores information about operators, wlantbe accessed while the system is
running. All other modules make use of it to process imageaijmans and to obtain information
about the configuration and current state of the system.

The knowledge base is also usedattomaticallygenerate the HALCON language interfaces
(for C, C++, and COM), all operator information used by HDepe the online help, and the
reference manuals. The operator knowledge base contéansiation about names and number
of operators, as well as parameter types, assertions aggsieg values for the parameters.
This data set is stored in a structured way. There existsaale@idescription for each operator
which handles the effects of the operator and which indgcéite complexity, the operator class,
as well as cross references and alternatives.

On top of these two modules the operators are implementedst bfahem are contained in
the HALCONmMmage Processing Librargoperator library), which is decribed in the Reference
Manuals. This library can be extended dynamically usingatedextension packagesrhe
operators of these packages behave like normal HALCON tpsrabut they contain exten-
sions to the standard library either generated by MVTecd#my update) or by the user. This
concept permits the user to extend the system in a very feexilaly. For more information
see theeExtension Package Programmer’s Manublsing a similar mechanisnframe grabber
interfacesare integrated using dynamic libraries. This allows the tséntegrate his/her own
frame grabber or to download new releases of frame grabtexfaces via the internet for fast
and easy update without further changes of the rest of thersys

The next module is théanguage-Independent Operator Interfack contains modules for
calling operators, handling the input/output and passatg dbjects to the host language. An
operator call is performed by tHeanguage Interfacewhich is generatedutomaticallyby a
compiler using the information in the operator database. erd&ftare three language inter-
faces: HALCON/C allows to access HALCON operators withi@ gnogramming language C,
HALCON/C++ within C++, and HALCON/COM (Windows NT/2000/Xénly) within pro-
gramming languages or environments that support COM, Bigrpsoft Visual Basic , C#, or
Borland Delphi. Note that you can also use HALCON/COM witkisual C++ programs, but
then you cannot use HALCON/C++ in the same program, becaniyeone HALCON lan-
guage interface can be used in a single application, besictyror indirectly, e.g., by including
a DLL that uses a second interface.

HDevelop is implemented on top of the language interfacegudie language interface HAL-
CONJ/C and the GUI toolkitvxWindows developed by thétrtificial Intelligence Applications
Instituteat The University of Edinburgto get a portable user interface for Windows and UNIX.

4.2 Handling Iconic and Control Data

HALCON distinguishes two types of dataconic dataandcontrol data Iconic data is related
to the original image (images, regions, XLD objects; se@wgl Control data are all kinds
of “numerical” values, such as integers, floating-point iens, or strings; this kind of data
defines input values for operator control parameters andasl to build complex structures
like bar charts or arrays of control values. Bothieenic andcontrol data — are processed
according to the “tuple scheme” within HALCON.
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4.2.1 Tuple Processing

Whenever an input or output parameter of a HALCON operatotains data, it may be a single
object/value or duple of objects/values. If a tuple is passed HALCON processesplegator
simultaneously on all tuple members. For example, if youtvt@arprocess a median filter on
six different images, you might call the operat@dian_image Six times with varying input
images. Or you might generate a tuple containing all six iesa@nd calihedian_image once
with the tuple as input object. HALCON filters all tuple elem&simultaneously and returns a
tuple containing six filtered images. We have seen anotrenple before irchapter 3where
several regions have been extracted from an input imagerefiens became elements of one
region tuple. If you want to know the center of all regions,ygimply have to pass this tuple to
the operatoarea_center. HALCON then returns a tuple of integer pairs containingpghes|
positions of all centers.

Now that we know how tuples are processed we can have a clusgleat the different object
classes of iconic data: images, regions, and XLD objects.

4.2.2 Image Objects

Image objects contain the pixel data for image processihgy may be tuple objects containing
more than one image object or a single image object. Evegjesimage object consists of one
domaindescribing its area of definition and one or mohannelsontaining the gray values of
the pixels (cffigure 4.3. The number of channels is not restricted. A monochromgeéemay
only have one channel, a color image may contain three clleaneording, e.g., to the RGB
scheme, a multisensor image may have several channels.

The domain of an image object may be of any size and is repiegsbéy aregion Thus, it can
have holes or may consist of several, unconnected areagge®4.3. The default domain of
an image object is the smallest rectangle enclosing theemkgnay be changed to any size,
e.g., via the operatateduce_domain, SO that every image has its individual domain.

Introducing an area of definition for an image has the follap@dvantage: All image operators
work only within this image domain. This allows to focus thegessing on &gion of interest
The amount of data to work on becomes smaller so that the gsimzeis sped up. An example
that explicitly makes use of this can be found as HDevelog@m namecutobahn.dev
under the patffHALCONROOT?,\examples\hdevelop\Applications\Sequences.

4.2.3 Region Objects

Regions define areas in images, e.g., the domain of an imatie dight areas of an image.
Region objects consist of one or more regions. They are bdradl separate objects independent
from any image object, although they may represent an arnbawvea specific image. This allows
to use flexible shapes and sizes for regions and to store tfiemergly. Only the region area
must be represented in memory — independent from the grapgsalf the pixels. Moreover,
this allows to define overlapping regions for the same imaigieowrt the implicit merging that
would happen when storing regions as matrices.

Region data is represented by a special variant of the rgtileencoding — by ahord encod-
ing: for every line (chord) of a region, its row index (y-coordta of chord; “line number”) and
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Figure 4.2: Structure of HALCON image objects.

regions may contain holes regions may be compact

NN

regions may consist of regions may exceed
several, unconnected areas the image size

Figure 4.3: Different forms and sizes of regions.

the x-coordinates of its start- and end-point is storedhBetthe start-point and the end-point
— belong to the region. This allows a very compact represiemtaf regions in memory and
an efficient region processing, especially with morphotiperations.
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Regions may be of any size and therefore even may exceed tgeigize. This is an ad-
ditional advantage, since it prevents artifacts. For examimnagine you want to close a
region with a circular structuring element to smooth theiaeg boundaries and to close
holes within the region, e.g., via the operatdrosing circle. You use this to extract
a little fin (seefigure 4.40r cf. the HDevelop program exampfen2.dev under the path
%HALCONROOT?\examples\hdevelop\Applications\FA). The closing is done by a dilation
followed by an erosion, both with the same circular struogelement — in our case a circle of
radius 250 (you may think that 250 is rather large, but withadvanced performance of HAL-
CON this causes no performance problem). Now imagine tleatrigiximum region size would
be restricted to the image size. Thus after processing thtestiep (the dilation) the resulting
region has to be clipped to the image size (sgare 4.4a). The following erosion would work
on a restricted area and therefore result in a much smaéartaan the correct processing (see
figure 4.4b). This would make the correct extraction of the fin impblesi

region after dilation
within background region

original image background r\egion

region after clipping region after erosion within
clipped region

region after e@sion without clipping

®) difference between this region
and the background region
exctracts the fin!

resulting region is too
small; correct extraction
of the fin is not possible!

Figure 4.4: Example of region processing.

4.2.4 XLD Objects

XLD is the abbreviation forXtended. ine Description. This is a data structure used for describ-
ing areas (e.g., arbitrarily sized regions or polygons)ror @osed or open contour, i.e., also
lines. In contrast to regions, which represent all areasxal precision, XLD objects provide
subpixel precision. There are two basic XLD structurestaors and polygons.
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An XLD object is built up by setting base points along the camtlines and connecting them
with lines. They can represent a contour (or set of lineshgtaecision by varying the number
and position of the base points at subpixel precision. Aaidit information, such as gradient,
filter response, or angle is stored with the points and lifigpically, XLD objects describe the
result of operators for edge/line detection (eegges_sub_pix, lines_gauss). In particular,
they are used for image processing at subpixel precisioroieda wide range of features and
transformations. See thextension Package Programmer’s Manfealinternal details.

4.3 The HALCON Frame Grabber Interface

Currently, HALCON provides interfaces about 5@rame grabbers, in form ofynamically
loadable libraries(Windows: DLLs; UNIX: shared libraries). These librariese anstalled
together with the HALCON libraries (sesection 2.1.4or the file structure). Library names
start with the prefiFG; the libraries starting witlparHFG are used by Parallel HALCON (see
alsosection 5.3.2

In the following, we give a brief overview of the HALCON frangeabber interface; please refer
to theApplication Note on Image Acquisitioior detailed information about this topic.

The HALCON frame grabber interface libraries form the badgetween software provided by
the frame grabber’'s manufacturer and HALCON. They form arooam, generic interface by
providing the following operators:

open_framegrabber opens and configures a specified frame grabber. Dependiing drame
grabber, several parameters must be specified, e.g. dagdtile type of the used camera
or the port the camera is connected to.

info_framegrabber returns information about a specified frame grabber, ehg. default
parameters used ypen_framegrabber.

set_framegrabber_param andget_framegrabber_param allow to set or read additional pa-
rameters. Which parameters are supported by a HALCON fraatgbgr interface can be
queried via the operatdmfo_framegrabber.

grab_image andgrab_image_async grab an image from a specified frame grabber. For the
difference between the two modes of grabbing see below.

grab_image start starts an asynchronous grabbing from the specified framabgrasee
below for more details).

close_framegrabber andclose_all framegrabbers close the connection to one or all
frame grabbers and release the corresponding resourgesfree the previously allo-
cated memory.

set_framegrabber_lut andget_framegrabber_lut allow to set or read a frame-grabber-
specific lookup table. These operators are only supportewine frame grabbers.

!Please refer tattp: //www.mvtec.com/halcon/framegrabber for an up-to-date list.
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If you successfully installed your frame grabber, all yoedéo do to access it from HALCON

is to call the operataspen_framegrabber, specifying the name of the frame grabber and some
additional information, e.g., regarding the connectedex@n Then, images can be grabbed
by calling the operatograb_image (Or grab_image_async, See below).

Please note, that the HALCON frame grabber interfaces maggdmore often than the HAL-

CON library itself. One reason is that MVTec continuouslye&leps new interfaces; further-
more, if the software provided by the frame grabber manufacs changes, e.g., if new fea-
tures are integrated, the corresponding HALCON interfag#isbe adapted. You can find

the latest information together with downloadable integfa(including documentation) under
http://www.mvtec.com/halcon/framegrabber.

4.3.1 The Two Modes of Grabbing Images

HALCON distinguishes two grabbing modes: synchronous aymehronous grabbingsyn-
chronous grabbingneans that the application tells the frame grabber to gradaimage by
calling the operatograb_image, and waits until the image is ready. In other words, the appli
tion synchronizes itself with the grabbing process. Theaathge of this mode is that grabbed
images are always up to date. However, because the grablongss can take quite a time
to complete, e.g40ms with standard PAL, real-time image processing become<diff{if
not impossible) using synchronous grabbing. Synchroneaisbjng is even more problematic
when using an external trigger (see the following sectiaa)hen the application will wait for
the trigger.

The second mod@&synchronous grabbingupportgeal-time image processingn this mode,
the grabbing process is divided into two steps: First, thaiegtion tells the frame grabber
to start grabbing a new image by calling the opergfotb_image start. This operator im-
mediately returns; thus, the application can continue watlown task, e.g., process the previ-
ous image while the frame grabber grabs a new image. To §cfetth the new image, the
application calls the operat@rab_image_async. If the frame grabber has already finished
grabbing the imagegrab_image_async returns directly with the image; otherwise the operator
waits until the frame grabber has finished. Furthermgargé_image_async allows to specify
“how old” the grabbed image is allowed to be. If the image is &dd, grab_image_async
automatically starts a new grab and waits for its completiBefore returning, the operator
grab_image_async automatically starts a new grab; therefore, you do not neealt the op-
eratorgrab_image_start anymore after the first grab.

Note, that asynchronous grabbing is the more powerful ofwleemodes, but requires a careful
timing on the part of the user. In other words, image proogs&@pplication side) and grabbing
process (frame grabber) can only run asynchronously if fheraiorgrab_image async is
called when the image is already grabbed (and not too olddy)é

4.3.2 Using External Triggers

Independent of the grabbing mode, you can usexarnal trigger signako start the actual
grabbing process in the camera (if the frame grabber supfiostoption) and thereby synchro-
nize the image grabbing to a physical process, e.g., by ysiogpelectric barriers that report
when a part has arrived for inspection. All you need to do thss feature from HALCON is
to specify a corresponding parameter in the calijen_framegrabber.
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Please note the difference between the two ways of syncingndescribed here and in the
previous section: In the synchronous grabbing mode, yquiicgtion software is synchronized
with the process of image grabbing so that image processants slirectly after getting a new
image. When using an external trigger, image grabbing isleymized with an external process
so that the grabbed image corresponds to a certain sityatignwith an object directly under
the camera.

When using an external trigger signal, keep in mind that &iéeng told to grab an image the
frame grabber walits for this signal — possibly ad infinitutimi$ signal is not triggered! Together
with the frame grabber, calls to the operagatab_image (and evengrab_image async, if
called before the signal comes) have to wait.

Most HALCON frame grabber interfaces allow to specify a tomefor grabbing via the oper-
ator set_framegrabber_param. If a grab runs into a timeout, the corresponding operator
returns the valug_ERR_FGTIMEQUT.

Please note, that in order to really synchronize the gra@pbpnocess with an external event,
the camera must be able to start a new image immediately. f&aiare is typically called
asynchronously resettablé a camera does not have this feature, the frame grabberwaits
for the camera to finish its current frame before starting&dogThis means that there will be a
delay between the external trigger and the start of the gngbliEven worse from the point of
view of real-time applications, the exact duration of the¢ay is unknown, as it may lie between
zero and the time needed for one frame.

Summarizing, in applications with hard real-time constigexternal triggers should be used in
conjunction with an asynchronously resetable camera anddyinchronous grabbing mode.

4.3.3 \Volatile Image Grabbing

By default, the operatorgrab_image andgrab_image_async copy the image data written by
the frame grabber into a certain memory area into a HALCONgenabject. The advantage
of this mode is that your application can process the retummage object as long as it likes
without it being “overwritten” by a subsequent grab. Furthere, the application can keep a
history of images if necessary.

As copying costs processing time (typically ab@ut 3ms for a NTSC image) which might
be precious in a real-time application, some HALCON framabber interfaces offer the so-
calledvolatile grabbing modeln this mode, the frame grabber directly writes the imaga da
into a HALCON image object used by the application. Thus, apying is required. The
drawback of this mode is that older images will be overwnity subsequent grahghus the
name “volatile”.

Whether a frame grabber interface supports volatile grapbls noted in its online documenta-
tion.

2In fact, the HALCON frame grabber interfaces internally asso-callecouble bufferingstrategy to assure
that a HALCON application can process one image while the inexge is grabbed. Then, buffers are switched
so that with the third grab the first image is overwritten.
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4.3.4 Using Frame Grabbers Without a HALCON Interface

If you use a frame grabber that is not yet supported by HALC@MN, can integrate a cor-
responding interface into HALCON. How to create and integieframe grabber interface is
described in th&rame Grabber Integration Programmer’s Manuwetich also contains sample
source code.

If you already have a program that communicates with the ARbar frame grabber and want
to use HALCON to process the images, you can convert the isnggobed by your program
to HALCON images by passing HALCON a pointer to the image dutising the operator
gen_imagel_extern.

4.4 Limitations

There are some HALCON limitations which you have to keep imdnialthough you won't
come even near these limits in most applications:

e Maximum image size: 3276X 32767

e Maximum number of image matrices in memarg00000
e Maximum number of objects per parameter: 100000

e Maximum number of channels per image: 1000

e Maximum number of values in a tuple: 1000000

e Maximum number of contour points: 30000

e Maximum number of polygon control points: 10000

e Range for coordinates: from32768 to +32767

e Maximum length of strings: 1024 characters

3Not to be confused with image objects, since objects caregharunderlying gray values.
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Chapter 5

Using Parallel HALCON

This chapter explains how to use Parallel HALCON, conceimgaon the main features of
Parallel HALCON: automatic parallelization and the suppdiparallel programming.

Like standard HALCON, Parallel HALCON can be used in two waysu can integrate the
corresponding libraries in your own C++, C, or COM prograorsjou can use the parallelized
variant of HDevelop, Parallel HDevelop.

Parallel HALCON and HDevelop

Like the HALCON library, HDevelop exists in two variants: &lstandard HDevelop builds
upon the standard HALCON library; as before the correspamnekecutable is callétievelop
(orhdevelop.exe). The second variant builds upon Parallel HALCON and theeeutomat-
ically parallelizes operators if used on a multi-procedsandware. The corresponding exe-
cutable is callegparhdevelop (Or parhdevelop.exe); under Windows NT/2000/XP, you can
start it via the men@tart > Programs > MVTec HALCON > Parallel HDevelop.

Note, that Parallel HDevelop differs from standard HDepeadaly insofar that it uses the auto-
matic parallelization mechanism. You cannot write patgitegrams inside Parallel HDevelop.

Parallel HALCON in a Stand-Alone Application

To create an application using Parallel HALCON, you mustkk lithe corresponding
libraries to your programs. Under Windows NT/2000/XP, yoeed the libraries
parhalconc.dll, parhalconcpp.dll, or parhalconx.dll, depending on the used pro-
gramming language. Under UNIX, you need the libraribhalcon.so and, depend-
ing on the used programming languagkibparhalconc.so Or libparhalconcpp.so.
Please consult thelALCON/C User's Manual, the HALCON/C++ User’s Manual, or the
HALCON/COM User’s Manua|l respectively, for more detailed information.

5.1 Automatic Parallelization

If Parallel HALCON is used on multi-processor hardware, iit automatically parallelize im-
age processing operatofBection 5.1.Hescribes how to initialize Parallel HALCON in order to
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use this mechanisngection 5.1.2xplains the different methods which are used by HALCON
operators for their automatic parallelization.

5.1.1 |Initializing Parallel HALCON

In order to adapt the parallelization mechanism optimallthe actual hardware, Parallel HAL-
CON needs to examine this hardware once. Afterwards, HAL@@igrams will be automat-

ically parallelized without needing any further action avuy part. Even existing HALCON

programs will run and be parallelized without needing to hanged.

You trigger this initial examination by calling the operatheck par hw _potential (See the
corresponding entry in the HALCON Reference Manuals fothfeir information). Note, that
this operator will only work correctly if called from ParallHALCON; if you call the standard
HALCON version (e.g., from HDevelop instead of Parallel WBkep), a corresponding error
message is returned. Similarly, if you call the operator aimgle-processor computer, it will
return an error message. As a shortcut, you may call the ed@eticheck parallel which
resides in the directoryHALCONROOT?,\bin\;ARCHITECTUREY.

Upon callingcheck_par_hw_potential, Parallel HALCON examines every operator that can
be sped up in principle by an automatic parallelization. lEacamined operator is processed
several times - both sequentially and in parallel - with angjiag set of input parameter values,
e.g., images. The latter helps to evaluate dependencieedetan operator’s input parameter
characteristics (e.g. the size of an input image) and thaeffty of its parallel processing. This
examination may take up to 10 minutes, depending on your otenp

The extracted information is stored in the registry (undendws NT/2000/XP) or in the file
.halcon_par_info in the directory$HALCONROOT (under UNIX). Please note, that on some op-
erating systems you need special privileges to initialiaeafel HALCON successfully, other-
wise the operatotheck_par_hw_potential is not able to store the extracted information. Un-
der Windows 2000, you need administrator privileges or ttoeig privileges’ Power User’.
Under UNIX, per default only the user who installed HALCONaaeate (or modify) the file
.halcon_par_info. Please note, that the operatbieck par hw potential returns without
an error if it cannot store the extracted information. Intcast, the programcheck parallel
checks privileges and writing permissions beforehand atwarms with a corresponding error
message.

5.1.2 The Three Methods of Automatic Parallelization

For the automatic parallelization of operators, ParallRLEBON exploitsdata parallelismi.e.,
the property that parts of the input data of an operator cgmrdeessed independently of each
other. Data parallelism can be found at three levels:

1. tuple level
If an operator is called with iconic input parameters carmitgg tuples, i.e., arrays of
images, regions, or XLDs, it can be parallelized by distifiithe tuple elements, i.e.,
the individual images, regions, or XLDs, on parallel thiea@his method requires that
all input parametersontain thesame number of tuple elemerfts contain a single
iconic object or value).
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2. channel level
If an operator is called with input images containing muéiphannels, it can be par-
allelized by distributing the channels on parallel threatisis method requires thatl
input image objectsontain thesame number of channeds a single channel image.

3. domain level
Every operator can be parallelized by dividing its domaid distributing its parts on
parallel threads.

The description of a HALCON operator in the Reference Maswalntains an entry called
'Parallelization Information’, which specifies its behawvivhen using Parallel HALCON. This
entry indicates whether the operator will be automaticpHyallelized by Parallel HALCON
and by which method (tuple, channel, or domain).

5.2 Parallel Programming Using Parallel HALCON

Parallel HALCON supports parallel programming by being#u-safe and reentrant, i.e., dif-
ferent threads can call HALCON operators simultaneousthaeuit having to wait. However,
not all operators are fully reentrant. This section takeleser look at the reentrancy of Parallel
HALCON. Furthermore, it points out issues that should be kemind when writing parallel
programs that use Parallel HALCON.

The example prograrixample multithreadedl.c in the directoryexample\c shows how to
use multithreading to extract different types of compos@mta board in parallel using Parallel
HALCON/C.

5.2.1 A Closer Look at Reentrancy

In fact there are different “levels” of reentrancy for HALGperators:

1. reentrant
An operator is fully reentrant if it can be called by multiglereads simultaneously
independent of the data it is called with.

2. local
This level of reentrancy is only relevant under Windows NODQ/XP.

Under Windows NT/2000/XP, operators markedasl should be called only from the
main thread(and not from arexternal threadl Typical examples are operators that use
graphical I/O functions. The reason is that under Window¢2QU0/XP, there exists
a direct mapping between program threads and graphicaleelsmsuch as windows,
dialog boxes or button controls. In short, a graphical el@noaly exists in the context
of its associated thread. This can cause severe problenex@mple, hang the applica-
tion) if a thread tries to perform user interactions via gniapl elements that belong to
another thread. For example, you may get a deadlock if oeadhopens a window via
open_window and another thread tries to get input from this windowdtiaw_circle.

As itis not always obvious whether an operator works wittical (graphical) elements
or not, such operators are marked@sal. Note, that you can still use them outside the
main thread, however, you might get problems.
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3. single write multiple read
A certain group of operators should be called simultangawdl if the different calling
threads work on different data. For example, threads shmatitry to modify the same
template for pattern matching simultaneously by calliigpt _template with the same
handle. Exactly the same applies to the case that one thineattisnot modify a data set
that is simultaneously read by another thread. Other grotipperators with this be-
havior are concerned with file I/O (e.grite_image —read image, fwurite string —
fread_string but also non-HALCON file commands) or background estimateg.,
update_bg_esti —give_bg esti).

As this thread behavior is not recommended quite geneRdigllel HALCON does not
actively prevent it and thus saves overhead. This meansftyati (accidentally) call

such operators simultaneously with the same data no thrébdlock, but you might

get unwelcome effects.

4. mutual exclusive

Some operators cannot be called simultaneously by multipésads but may be exe-
cuted in parallel tmtherHALCON operators. Examples for mutual exclusive operators
arecombine_roads_x1d, pouring, Of concat_ocr_trainf.

5. completely exclusive
A group of operators is executed exclusively by Parallel KRN, i.e., while such an
operator is executed, all other threads cannot call anbtACON operator. Examples
are all OCR/OCYV operators that modify OCR classificatolspjaérators that create or
delete files, and the operatosset_obj_db. For the latter, a programmer has to assure
that all operators that are to be execubsdorereset_obj_db is called have already
finished, because this operator resets HALCON and thersfooagly influences its
behavior.

As mentioned already, the description of a HALCON operatdhe Reference Manuals con-
tains an entry called 'Parallelization Information’, whispecifies its behavior when using Par-
allel HALCON. This entry specifies the level of reentrancydascribed above.

5.2.2 Style Guide

Initialization

Before calling HALCON operators in parallel in a multithdea program, you have to
call one operator exclusively. This is necessary to allowL@®N to initialize internal
structures.

In principle, you can choose any HALCON operator for thigiaticall; we recommend
reset_obj_db as this operator initializes the global image size.

1/O

Under Windows NT/2000/XP, use /O operators (includingpiiias operators like
open_window Or disp_image) only in the main threadotherwise you might get a dead-
lock. This means that you should not open a window in one thee®sl request a user
interaction in it from another thread. In the Reference Maihese operators are marked
aslocally reentrant(seesection 5.2.1

Keep in mind that operators which create or delete files weclusively, i.e., other threads
have to wait.
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The programmer has to assure that threads do not accessbdilga(or handle) simul-
tanously!

e Multithreading vs. Automatic Parallelization
If you explicitely balance the load on multiple processarsaimultithreaded program,
we recommend to switch off the automatic parallelizationchamism in order to get
an optimal performance. How to switch of the automatic peliahtion is described in
section 5.3.1

5.3 Additional Information

This section contains additional information that helps y@use Parallel HALCON.

5.3.1 How to Switch Off Reentrancy or Automatic Paralleliza  tion

You can switch off parts of the features of Parallel HALCONMwihe help of the operator
set_system. To switch off the automatic parallelization mechanisnil, @¢édDevelop notation,
see the Reference Manual for more information)

set_system(’parallelize_operators’,’false’)

To switch of reentrancy, call

set_system(’reentrant’,’false’)

Of course, you can switch on both behaviors again by caklikg system with the >true’
as the second parameter. Please note, that by switchingeaftrancy you also switch off
automatic parallelization, as it requires reentrancy.

Switch off these features only if you are sure you don’t ndwesht but want to save the corre-
sponding computing overhead. If you write sequential paiogg to be run on a single-processor
computer, the best way to save overhead is to use standar@BAll.of course.

A reason for switching off the automatic parallelizationahanism could be for debugging or
if your multithreaded program does its own scheduling aresdwt want Parallel HALCON to
interfere via automatic parallelization. Note, that youra need to switch off automatic par-
allelization when using Parallel HALCON on a single-pramscomputer; Parallel HALCON
does not create any corresponding overhead if it detecysomd@ processor.

5.3.2 Using a Frame Grabber in Parallel HALCON

All frame grabbers supported by HALCON can be used in Pdr&ieBLCON as well.
Please note, that none of the frame grabber operators isnatitally parallelized. Most
of the operators are reentrant, only the operators condemigh the connection to
the frame grabberopen framegrabber, info_framegrabber, close_framegrabber, and
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close_all framegrabbers) are processed completely exclusively. Furthermore etloper-
ators ardocal, i.e., under Windows NT/2000/XP they should be called frowva main thread
(seesection 5.2.1

Under Windows NT/2000/XP, each frame grabber interfaceesoastwo DLLS', one for stan-
dard HALCON (prefixHFG) and one for Parallel HALCON (prefigarHFG). Both HALCON
versions automatically load “their” interface librarie®, you do not need to worry about it.

Under UNIX, both standard HALCON and Parallel HALCON worktlwthe same shared li-
brary (prefixHFG).

5.3.3 Extension Packages and Parallel HALCON

To be used in Parallel HALCON, extension packages must beiged in a second version
including the prefixpar in the name of the libraries. For example, if the package iied¢a
halconuser, Parallel HALCON looks for the librariesrhalconuser.d11l under Windows
NT/2000/XP orlibparhalconuser.so under UNIX, respectively.

More information about extension packages in Parallel H®INC can be found in the
Extension Package Programmer’s Manual

5.3.4 Parallel HALCON and HALCON Spy

As HALCON Spy (seesection 6.4 is working sequentially, it cannot be used to monitor a
Parallel HALCON program.

1seesection 2.1.4or the file structure of HALCON
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Chapter 6

Tips and Tricks

This chapter contains information that helps you workinghvHIALCON, including sections
on troubleshooting.

6.1 News About HALCON

If you select HDevelop’s menu enthglp > HALCON News (WWW), you can check for the latest
news about HALCON on MVTec’'s WWW server, e.g., whether neteesion packages, frame
grabber interfaces, or HALCON versions are available.

6.2 A Note on Windows 2000 and Windows XP

By default, Windows 2000 and Windows XP use visual effectsg,, @vhen opening menus,
that as a side-effect slow down programs with graphics dutputhe context of HALCON,
especially HDevelop is affected significantly. We therefoecommend to disable these effects
in the dialogStart > Settings > Control Panel > Display.

6.3 Online Help in HDevelop

HDevelop offers you a broad range of support.

e System suggestions
Based on theperator knowledge bas¢he system offers specific advice to choose an
appropriate operator. Thus, there are suggestions foomebtepredecessorand suc-
cessors If you are searching for different ways of solving an imagelgsis problem
you may have a look alternativesor referencef an operator. If you only have some
keywords or thematic aspects in mind which an operator hagfilh, but you cannot re-
member the operator’s name, you have the possibility toimltaoperator by specifying
one or more&keywords
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e Online help on operators
HALCON offers a detaile@nline helpfor each HDevelop operator. These manual pages
are highly structured, thus allowing you to easily get anarathnding of an operator.
Moreover,cross referencesnmediately give you a survey of the operator’s relations. T
use this help you only need a standard HTML browser.

e Debugging help
You may choose between differenbdes of running program. You have the possibilities
to perform single steps of a program, to set breakpoints arrt a program continuously.

To get meaningfudebugging supporyou may also specify the environment variable
HALCONSPY (seesection 2.4.p

e Result visualization
HDevelop offers the immediat@spectionof an operator’s results. This visualization
mechanism helps you to spot problems quickly. Additionatlys very easy for you to
modify graphics output parameters to optimize your graphasults.

6.4 Monitoring HALCON Programs with HALCON Spy

HALCON Spy helps you to debug image processing programg&esawith HALCON oper-
ators by monitoring calls to HALCON operators and displayiheir input and output data in
graphical or textual form. Furthermore, it allows you tosstierough HALCON programs.

HALCON Spy is activated within a HALCON program by insertitige line (in HDevelop
notation)

set_spy(’mode’,’on’)

Alternatively, you can activate HALCON Spy for an alreadykiéd program by defining the
environment variabl&HALCONSPYY, (i.e., by setting it to any value). How to set environment
variables is described ection 2.4

You specify the monitoring mode by calling the operatet_spy again with a pair of parame-
ters, for example

set_spy(’operator’,’on’)
set_spy (’input_control’,’on’)

to be informed about all operator calls and the names anesaitiinput control parameters.
The monitoring mode can also be specified via the environwerdable),;HALCONSPY%. Under
Windows NT/2000/XP, séfHALCONSPY?, to the value

operator=on;input_control=on

to get the same mode as in the example above. Under UNIX, c@leminstead of a semicolon
to separate options.

Please take a look at the entry fest_spy in the HALCON Reference Manuals for detailed
information on all the debugging options. Note, that HALC@Ny does not work properly
under Parallel HALCON.
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6.5 Troubleshooting

This section offers help for problems encountered durisggiting or uninstalling HALCON,
when using HDevelop, or when using Parallel HALCON.

6.5.1 Problems During Installation

e Registration of halconx.d11 failed
On some systems you might get a warning message that the HNLQOM interface
library halconx.d11 failed to self-register. A possible cause for this may b¢ tihe Mi-
crosoft libraryatl.d11 was not registered properly. This library resides in thedaory
%SystemRoot%\system32, e.9.,C: \WINNT\system32. To register the library, open a
Windows Command Prompt, change into the direcinryc\i586-nt4 on the CD, and
execute the supplied programg_halconx twice as follows:

reg_halconx atl.dll
reg_halconx

The first call ofreg_halconx registersatl.dl1, the second one registérslconx.d11.

As an alternative to the Command Prompt, you can use thegdfalart > Run; here,
you must either type the full path of the prograweg_halconx or select the program via
the buttorBrowse.

¢ Installing and uninstalling the license manager daemon
Occasionally, the FLEXIm license manager daemon needefiiofating licenses is not
installed properly by the HALCON setup. How to install theeihnse manager daemon
manually is described isection 2.3.4.1

6.5.2 Problems During Uninstallation

e Unregistration of halconx.d11l
If you had to register the HALCON/COM interface libranalconx.d11 manually as
described irsection 6.5.1you must unregister it manually before you can uninstalLHA
CON. To do so, insert a HALCON CD, then open a Windows Commarunpt,
change into the directonyisc\i586-nt4 on the CD, and execute the supplied program
reg_halconx as follows:

reg_halconx /u

As an alternative to the Command Prompt, open the digtegt > Run, select the pro-
gramreg_halconx via the buttorBrowse, append the optioru, and then clicloK.

e Uninstallation of the license manager daemon
As mentioned irsection 2.2.1if you uninstalla HALCON 5.0 or 5.1 version with floating
licenses the FLEXIm license manager daemon occasionatptisininstalled properly.
How to uninstall the license manager daemon manually isribestinsection 2.3.4.1
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e “Internal Error”
If the uninstall process is terminates with a message like

“Internal Error, unable to load or call external DLL. Please contact your
distributor for more information.”

the most likely reason is that a new HALCON version was itethbver an existing one
without completely removing the old files first.

Other possible reasons might be that the whole HALCON dirgcivas moved to an-
other position on the hard disk, or the environment varigHk.CONROOTY, was changed
manually. You have to follow the following steps to recovemh the error:

1. Check if the environment variablgHALCONROOT% matches the location of
your HALCON directory. You can check this via the system coint
panelSystem (look for Environment) or in a Windows Command Prompt via
echo %HALCONROOTY%. If the variable contains nothing or the files are in some
other location, you have to set HALCONROOT manually via $getem control
panel.

2. Check if these following files / directories are present:

¢ In the directory),HALCONROOT%\FLEX1m\1586-nt4: HalconUninst.d11?!
Note that by default the Windows Explorer doesn’t show DLEdjl unless
you explicitly tell it to do so.
HalconUninst.d1ll is a HALCON specific DLL for the uninstallation pro-
cess. If this file has been removed you can get a copy of therdita the
directoryFLEX1m\i586-nt4 on the HALCON CD.

e Only for HALCON releases > 6.1
In the directory C:\Program Files\InstallShield Installation
Information (Or similar): the directory
{BBEC9F40-4A36-11D6-A14C-00E0296C2846} with a set of files.
This directory has been created during the installation. it as been
removed, an automatic uninstallation is not possible.

e Only for HALCON releases < 6.1
In your HALCONROOTY directory:Uninst.isu
This file has been created during the installation. If it hesrbremoved, an
automatic uninstallation is not possible.

3. Check, if the registry entry for the uninstaller is setg@dy: Startregedit.exe
in a Windows Command Prompt or in the dial®gart > Run.

e Only for HALCON releases > 6.1
Goto

HKEY_LOCAL_MACHINE -> SOFTWARE -> Microsoft -> Windows ->
CurrentVersion -> Uninstall ->
{BBEC9F40-4A36-11D6-A14C-00E0296C2846}

There, you should find a key nam&dinstallString. The value of this
string should be something like this (the optien . . is only included if you

1For HALCON 5.0 and 5.1, this DLL was calle¥$Uninst.d11.
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have chosen an installation with floating licenses):

RunD1132 C:\PROGRA™1\COMMON~1\INSTAL"1\engine\6\INTEL3"1\
Ctor.dl1l,

LaunchSetup "C:\Program Files\InstallShield Installation
Information\{BBEC9F40-4A36-11D6-A14C-00E0296C2846}\
setup.exe" -10x9 UninstallHALCON

Make sure that the path: \Program Files\MVTec\HALCON (or equivalent)
in the above example points to tBALCONROOTY, directory. Note that file-

names that contain blanks have to be quoted with'path". This is true
in the above example since “Program Files” does contain akblaDlder
versions of the HALCON setup program failed to do so. If yoe@mter
unquoted path names containing blanks, please insert thi@atgpn marks
yourself.

e Only for HALCON releases < 6.1
Goto

HKEY_LOCAL_MACHINE -> SOFTWARE -> Microsoft -> Windows ->
CurrentVersion -> Uninstall -> HALCON <Version-Number>

with <Version-Number> being the version number of the HALCON version
you want to uninstall or is not present. There, you should &ifey named
UninstallString. The value of this string should be something like this
(the option-c. .. is only included if you have chosen an installation with
floating licenses):

C:\WINNT\IsUninst.exe

-f"C:\Program Files\MVTec\HALCON\Uninst.isu"
-c"C:\Program Files\MVTec\HALCON\FLEX1m\i586-nt4\
HalconUninst.d11l"

Make sure that the path: \Program Files\MVTec\HALCON (or equivalent)
in the above example points to tBALCONROOTY, directory. Note that file-

names that contain blanks have to be quoted with'path". This is true
in the above example since “Program Files” does contain akblaDlder
versions of the HALCON setup program failed to do so. If yoe@mmter
unquoted path names containing blanks, please insert thi@tgqpn marks
yourself.

4. Close the registry editor and try to run the uninstallexiag

e Uninstallation failed
If the automatic uninstallation fails for another reasavgeed as follows:

e For floating licenses only:  Uninstall the license managentan as described in
section 2.3.4.1

e Startregedit and delete the key

HKEY_LOCAL_MACHINE -> SOFTWARE -> MVTec -> HALCON
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e Only for HALCON releases > 6.1
Also delete the key

HKEY_LOCAL_MACHINE -> SOFTWARE -> Microsoft -> Windows ->
CurrentVersion -> Uninstall ->
{BBEC9F40-4A36-11D6-A14C-00E0296C2846}

e Only for HALCON releases < 6.1
Also delete the key

HKEY_LOCAL_MACHINE -> SOFTWARE -> Microsoft -> Windows ->
CurrentVersion -> Uninstall -> HALCON

e Using, e.g., the Windows Explorer, delete the directory

%SystemRoot%\Profiles\All Users\Start Menu\Programs\MVTec HALCON

Note that/;SystemRoot? usually iSC: \WINNT.
e Finally, delete the HALCON base directok#ALCONROOT?.

6.5.3 Problems Concerning Licenses

If you encounter problems with your HALCON license even tijloyour license file exists and

is located in the correct directory, a first step is alwaysheak if the information identifying
your computer (or dongle) (sesection 2.3.Lmatches the corresponding entries in the license
file (seesection 2.3.R If the two do not match, please send the new identifyingnimfation to
your distributor. See below if you encounter problems witracting the identifying informa-
tion.

If you are using floating licenses, please have a loaseation 2.3.4especially regarding the
choice of a suitable port number for the license manager daem

If you are using a dongle-bound license with HALCON 6.0.2 mhler and get the message
“license not found” or a similar error message, you mightchee uninstall the old dongle
driver and install the new one manually as describeskiction 2.3.5.1

6.5.3.1 Problems When Extracting Identifying Information

e “About HDevelop” does not show any host IDs

If HDevelop fails to detect any host IDs although your congpudoes have a network
board, a Pentium Ill, or a dongle, please try to extract thet Has manually as described
in section 2.3.1.2

e Licensing via network card does not work when network is not onnected

On Windows 2000 and Windows XP systems, you must disable M&dinse
(DHCP) when no network is connected to the network card. lWsud is suffi-
cient to disable the DHCP protocol in this case. Furtheridetzan be found under
http://support.microsoft.com/support/kb/articles/Q239/9/24.asp.
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e lmhostid -ether returns "ffffffff" or "0"
If lmhostid returns"ffffffff" or "0", this usually indicates that you do not have a
network board. If you do have one, on Windows 2000 and Windéissystems check
whether the client for Microsoft networks is installed iretialogStart > Settings
> Network and Dial-up Connections > Local Area Connections > Properties.
If the client for Microsoft networks does not appear in th& install it by clicking
Install and then selecting it from the list of clients. Then, repbat $teps described
in sections 2.3.1.0r2.3.1.2

On Windows NT systems check whether the NetBEUI and TCP/@Ropols are installed
in the dialogStart > Settings > Control Panel > Network > Protocol. If the proto-
cols do not appear in the dialog, please install these twtmpots by adding them in the
dialog. Then, repeat the steps describesgdations 2.3.1.br 2.3.1.2

e Multiple IDs for only one network card

On Windows 2000 and Windows XP systems, sometimes more theuhlbis returned
even if there is only a single network card. In this case, hedD that remains when both
the NetBEUI and IPX/SPX protocols are disabled. Alterreltivuse the ID that does not
change when you reboot the machine.

e Imhostid -cpu64 returns ""
If Imhostid returns an output like
> 1lmhostid -cpu64
lmhostid - Copyright (C) 1989-2000 Globetrotter Software, Inc.

The FLEXIm host ID of this machine is ""
Imhostid: FLEX1m function not available in this version <-45,520>

this indicates that the processor of your computer doesmwtge a CPU ID. As described
in section 2.3.1.2the most probable reason is that the service providing e @ is
disabled in the computer’s BIOS. You can check and enabte déivice in the BIOS
configuration mode.

If you cannot find a corresponding service entry in the BIO$afr computer, this means
that its processor does not provide a CPU ID. Note, that atlr@nly Pentium Il pro-
cessors provide this ID; the output above, e.g., stems froAND Athlon processor.

e lmhostid -flexid does not return the dongle ID

If Imhostid does notreturn the ID that is printed on the back of the dqrgleck whether
the dongle driver is installed and configured correctly axdbed insection 2.3.5

If the driver is installed butmhostid still does not return the correct ID, please check the
corresponding port (parallel or USB) of your computer, bef@questing a new dongle.

6.5.4 Troubleshooting in HDevelop

This section explains some typical errors while startinge@€op and their reasons.

e No license found
This error message might have several reasons:
- The file,HALCONROOTY\1icense\license.dat is missing and/or not readable.
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- Your license is not valid on this machine.
- In case of floating licenses: There are too many licensegeacti

Lost connection to license server

Verify if the license server is running. You may also checketiter your machine is
properly connected with the server. For this you may needmbact your system admin-
istrator.

No license for this operator

The operator which you try to execute belongs to a HALCON nh@dvhich is not li-
censed. Obtain a new license including this module.

Wrong architecture

This error indicates that you are using an architecture lwisaot compatible with your
HALCON version. Check the variable ARCHITECTURE or try tafall the proper HAL-
CON version.

hdevelop: Command not found

Check your system environment variabATH. It has to include the path
$HALCONROOT/bin/$ARCHITECTURE.

lib* : can’t open file

For UNIX architectures you have to check the system variabl& IBRARY_PATH (see
section 2.4.2

No help files for package<package-name- in directory <directory >
Possible reasons for this error message are:

e No files%HALCONROOT%\help\* (if the package name is “system”) or no help files
in one of the user packages.

e If the package name is “system”: Wrong HALCONROOT

e Check the file protection. Probably HDevelop cannot acaeg®itant files.

Help file for package <package-name- is corrupt
Possible reasons for this error message are:
e If the package name is “system”: Inconsistent versiofHa.CONROOT/, \help\* or
wrong HALCONROOT

¢ |If the package name is that of a user package: Inconsistesibneof the help files
of this package.

Can’t open display
If you see an error message like this you may have a wrongmygaeiableDISPLAY
and/or your program is not allowed to open a window by the iipelcX-server.

6.5.5 Troubleshooting for Parallel HALCON

e Parallel HALCON does not achieve any speedup

If Parallel HALCON does not achieve any speedup on a muticessor hardware, maybe

Getting Started with HALCON, 2005-02-01



6.5. TROUBLESHOOTING 79

you forgot to initialize Parallel HALCON as described section 5.1.1 You must ini-
tialize Parallel HALCON once on each parallel hardware iioive used on. With this
initialization, Parallel HALCON scans the hardware andakiseits potential for parallel
processing.

If you already initialized Parallel HALCON, you can check &ther Parallel HALCON
really “found” the processors by calling the operagert_system with the parameter
’processor_num’ (See the corresponding entry in the Reference Manual foenmmor
formation). Please note, that this operator must be cailted Parallel HALCON to yield
meaningful results; from standard HALCON, it retumsegardless of the actual number
of processors.

Please remember that Parallel HALCON only works on sharedany systems!

e A Parallel HALCON program runs slower than expected within Visual Studio

Please note, that the developing environment MicrosoftdliStudiomassivelynfluences
the scheduling on a multi-processor computer. As a conseguerograms using Parallel
HALCON run slower than expected when starteithin Visual Studio. This concerns
both the automatic parallelization mechanism and muédbed programs in general.

To get the full performance, create a corresponding exblaifaexe-file) and start it
outsideVisual Studio.

e An operator returns different results in HALCON and Paralle | HALCON, respec-
tively
This problem can occur if you called the operator with inpatgmeters containinty-
ples Note, that certain input parameters of HALCON operatorstmot receive tuple
values; however, some operators will work without retugrém error in such a case. You
can check whether a parameter may receive tuples in thetopsrdescription (on-line
help or reference manual): Parameters that can receivestapé marked with the suffix
"(-array)’ after their type, e.g.,region(-array)’.

6.5.6 Miscellaneous Problems

e No refresh of window content on a UNIX system

On some UNIX systems the default behavior regarding ocdwdadows may be set in
an inconvenient way for HALCON. The result is that if a windmsatemporarily occluded
by another window, its content is not saved and restored argje., windows remain
“black” after uncovering. An example is the Linux distribart SUSE 7.0. The correspond-
ing property is called “backing-store”; you can check therent setting of this property
by typing (the following example corresponds to a SUSE 7rukisystem)

xdpyinfo | grep backing-store

which should result in the output like

options: backing-store YES, save-unders YES

if the window content is saved and restored. You can charigd#havior by modifying
the fileXservers residing in the directoryusr/1ib/X11/xdm (Or similar, see your sys-
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tem’s documentation). Note, that you probably need roatilpges to modify this file.
Append the optiorbs (i.e., “plus backing-store”) to the line that starts thedbX server:

:0 local /usr/X11R6/bin/X :0 vt07 +bs

Now, stop and start the X server again (by using the apprgr@nmands or by rebooting
your computer); the commandpyinfo now should yield the output shown above.
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